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PlasmaLab™
SOFTWARE LICENSE AGREEMENT

The software (which term shall include discs, computer program and related materials) supplied with 
the goods is the Confidential and Proprietary Information of the Vendor. Subject to the provisions of 
this agreement, the Vendor warrants that it is authorized to grant you a right to use the software with 
the goods. Installation of the goods and/or software is deemed to be your unconditional acceptance of 
this agreement.

Grant of Single User License of the Goods

In consideration of payment of the license fee which is part of the purchase price, the Vendor grants a 
right to use the software on a single computer with a single instrument. 

If the Purchaser wishes to use the software on more than one computer or instrument then the 
Purchaser expressly agrees to purchase an additional user license for each additional user copy from 
the Vendor.

Term

This agreement is effective from the date of delivery of the goods and/or software and continues until 
either or both are disposed of. The Vendor may terminate this agreement forthwith without notice if 
the Purchaser is in breach of the terms of this agreement.

Ownership of the Software

The Purchaser owns the magnetic or other physical media on which the software is originally or 
subsequently recorded or fixed, but an express condition of this agreement is that the Vendor retains 
title and ownership of the software recorded on the original disk copy(ies) and all subsequent copies 
of the software regardless of the form or media in or on which the original and other copies may exist. 
This agreement does not constitute a sale of the software or any copy.

Copy Restrictions

The software and the accompanying manuals are copyrighted. Unauthorized copying of the software 
including software which has been modified, merged or included with other software or of the written 
materials is expressly forbidden. The Purchaser may be held responsible for any copyright 
infringement which is caused or encouraged by a failure to abide by the terms of this agreement.



User Restrictions

The Purchaser may physically transfer the software from one computer to another provided that the 
software is used on only one computer at a time. The Purchaser may not distribute copies of the 
software or accompanying written materials to others. The Purchaser may not modify, adapt, translate 
reverse, engineer, decompile, disassemble or create derivative works based on the written materials 
without the prior written consent of the Vendor.

Disclaimer of Warranty and Limited Warranty

The Purchaser acknowledges that the software in general and the user manuals may not be error free 
and agree that the existence of such errors shall not constitute a breach of this agreement. However, 
the Vendor warrants that for a period of 12 months after installation or 13 months after delivery, 
whichever is the sooner, that under normal use the material of magnetic media and the user manuals 
will not prove defective. Furthermore and for the same period, the Vendor warrants that the software 
will prove to operate substantially complete and contain all information which the Vendor deems 
necessary for the use of the software.

The above is the only warranty of any kind, either express or implied, statutory or otherwise, 
including but not limited to the implied warranties of merchantability or fitness for a particular 
purpose that is made by the Vendor. No oral or written advice given by the Vendor, its dealers, 
distributors, agents or employees shall create a warranty or in any way increase the scope of this 
warranty and you may not rely on any such information or advice. The warranty gives you specific 
legal rights. You may have other rights which vary from location to location.

Your sole remedies and the entire liability of the Vendor and its suppliers are set forth above. In no 
event will the Vendor or its suppliers be liable to you or any other person for any damages whatsoever 
or howsoever arising including without limitation any direct, indirect, special, incidental or 
consequential damages, expenses, lost profits, lost savings or other damages arising out of use or 
inability to use the software.

Assignment

You may not sub-license, assign or transfer this agreement or the software without the prior written 
permission of the Vendor. Any attempt otherwise to sub-license, assign or transfer any of the rights, 
duties or obligations herein is void.
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Read This First

Welcome to the Thermo Fisher Scientific, XSERIES 2 system! The 
XSERIES 2 is a member of the Thermo Scientific family of advanced 
mass spectrometer (MS) detectors.

Who uses this Guide This XSERIES 2 Getting Started Guide is intended for all personnel that 
needs to operate the XSERIES 2, especially the key operator. This 
manual should be kept near the instrument to be available for quick 
reference.

Scope of this Guide This XSERIES 2 Getting Started Guide provides you with information 
on how to set up, calibrate, and tune the XSERIES 2. In addition, this 
manual provides step-by-step instructions for cleaning and maintaining 
your instrument.

This manual includes the following chapters:

• Chapter 1: “Optimizing the Signal” describes how to switch on the 
instrument, obtain the first signal and optimize the instrument.

• Chapter 2: “Initial Performance Checks” describes how to set up a 
short term stability test and how to perform a survey scan.

• Chapter 3: “Instrument Calibrations” describes how to calibrate the 
instrument for optimum performance. 

• Chapter 4: “Sample Analysis” describes how to set up an experiment 
for the analysis of standards and unknown samples.

• Chapter 5: “Operating PlasmaScreen” describes how to optimize 
and use PlasmaScreen in cool plasma mode and hot screen mode.

• Chapter 6: “CCT Operation” describes how to use Collision Cell 
Technology with different gases.

• Chapter 7: “Maintenance” describes how to clean the body of the 
XSERIES 2 and how to optimize pump performance.

• Chapter 8: “Troubleshooting” describes how to diagnose and resolve 
the most typical trivial problems.
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Read This First
Intended Use of the Equipment
Intended Use of the
Equipment

The equipment is intended to be used by trained personnel within a 
laboratory environment, for the purpose of chemical analysis. It should 
not be used for any other purpose or within any other environment. The 
instrument must not be used in an unspecified manner.

Reference Thermo Fisher Scientific Pre-Delivery Pack for intended use of 
the equipment including technical specifications, environmental 
conditions, laboratory preparation requirements and other health and 
safety issues.
ii XSERIES 2 Getting Started Guide Thermo Fisher Scientific



Read This First
Changes to the Manual
Changes to the
Manual

To suggest changes to this manual, please send your comments to:

Editors, Technical Documentation
Thermo Fisher Scientific
Hanna-Kunath-Str. 11

28199 Bremen

Germany

documentation.bremen@thermofisher.com

You are encouraged to report errors or omissions in the text or index.
Thank you.
Thermo Fisher Scientific XSERIES 2 Getting Started Guide iii



Read This First
Typographical Conventions
Typographical
Conventions

Typographical conventions have been established for Thermo Fisher 
Scientific manuals for the following:

• Data input

• Admonitions

• Topic headings

Data Input Throughout this manual, the following conventions indicate data input 
and output via the computer: 

• Messages displayed on the screen are represented by capitalizing the 
initial letter of each word and by italicizing each word.

• Input that you enter by keyboard is identified by quotation marks: 
single quotes for single characters, double quotes for strings.

• For brevity, expressions such as “choose File > Directories” are used 
rather than “pull down the File menu and choose Directories.”

• Any command enclosed in angle brackets < > represents a single 
keystroke. For example, “press <F1>” means press the key labeled 
F1.

• Any command that requires pressing two or more keys 
simultaneously is shown with a plus sign connecting the keys. For 
example, “press <Shift> + <F1>” means press and hold the <Shift> 
key and then press the <F1> key.

• Any button that you click on the screen is represented in bold face 
letters. For example, “click on Close”.
iv XSERIES 2 Getting Started Guide Thermo Fisher Scientific



Read This First
Typographical Conventions
Admonitions Admonitions contain information that is important, but not part of the 
main flow of text.

Admonitions can be of the following types:

• Note – information that can affect the quality of your data. In 
addition, notes often contain information that you might need if 
you are having trouble.

• Caution – information necessary to protect your instrument from 
damage.

• Warning – hazards to human beings. Each Warning is accompanied 
by a Warning symbol.

Topic Headings The following headings are used to show the organization of topics 
within a chapter:

Chapter Name

The following headings appear in the left column of each page:

Second Level Topics

Third Level Topics

Fourth Level Topics
Thermo Fisher Scientific XSERIES 2 Getting Started Guide v



Read This First
Safety and EMC Information
Safety and EMC
Information

In accordance with our commitment to customer service and safety, 
these instruments have satisfied the requirements for the European 
CE Mark including the Low Voltage Directive.

Designed, manufactured and tested in an ISO9001 registered facility, 
this instrument has been shipped to you from our manufacturing facility 
in a safe condition.

Caution This instrument must be used as described in this manual. Any 
use of this instrument in a manner other than described here may result 
in instrument damage and/or operator injury. ▲

Safety Warning Due to design changes and product improvements, the information in 
this document is subject to change without notice. Thermo Fisher 
Scientific reserves the right to change hardware and software designs, 
which may subsequently affect the contents of this customer 
information document. Thermo Fisher Scientific assumes no liability 
for any errors that may appear in this guide.

The methods and analytical procedures described in this and other 
manuals supplied with the XSERIES 2 are designed to be carried out by 
properly trained personnel in a suitably equipped laboratory. In 
common with many laboratory procedures, the methods described may 
involve hazardous materials or substances of unknown toxicity. For the 
correct and safe execution of the methods, it is essential that laboratory 
personnel follow standard safety procedures for the handling of 
hazardous materials.

Whilst the greatest care has been exercised in the preparation of this 
document, Thermo Fisher Scientific expressly disclaims any liability to 
users of these procedures for consequential damages of any kind arising 
out of or in connection with use of these procedures.

There are many sources of safety information available. Consult your 
chemical and laboratory supply catalogues. You may also refer to the 
CRC Handbook of Laboratory Safety, published by CRC Press Inc., Boca 
Raton, Florida. 
vi XSERIES 2 Getting Started Guide Thermo Fisher Scientific



Read This First
Safety and EMC Information
Identifying Safety
Information

The XSERIES 2 Getting Started Guide contains precautionary statements 
that can prevent personal injury, instrument damage, and loss of data if 
properly followed. Warning symbols alert the user to check for 
hazardous conditions. These appear throughout the manual, where 
applicable, and are defined in Table i.

Instrument-Specific
Hazards

Every instrument has specific hazards, so be sure to read and comply 
with the following general warnings and safety precautions. They will 
help ensure the safe, long-term use of your system. More specific 
warnings and recommendations are given in the corresponding chapters 
of the XSERIES 2 Getting Started Guide.

1. The system should be operated by trained personnel only. Read the 
manuals before starting the system and make sure that you are 
familiar to the warnings and safety precautions!

2. Accurate results can be obtained only, if the system is in good 
condition and properly calibrated.

Table i. Warning Symbols

Symbol Description

General This general symbol indicates that a hazard is present, which if 
not avoided, could result in injuries. 

The source of danger is described in the accompanying text. ▲

Electric Shock Voltages above 50 V ac are present on the instrument.

The instrument must be shut down and disconnected from line power 
before service or repair work is performed. ▲

Dangerous Chemicals Chemicals are used in the normal operation of 
the instrument that may present a hazard. 
Ensure safety precautions are taken when dealing with hazardous 
liquids. ▲ 

Flammable Liquid Some applications may use flammable solvents.

Ensure safety precautions are taken when using flammable liquids. ▲

Hot Surface / Heat Heat is generated by internal components within 
the XSERIES 2. 
Ensure that the cooling outlets on the back panel of the XSERIES 2 
remain unobstructed at all times. Allow heated components to cool 
down before servicing them! ▲
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Read This First
Safety and EMC Information
3. Service by the customer should be performed by trained qualified 
personnel only and should be restricted to servicing mechanical 
parts!

4. Service on electronical parts should be performed by Thermo Fisher 
Scientific Service Engineers only!

5. Before plugging in any of the instrument modules or turning on the 
power, always make sure that the voltage and fuses are set 
appropriately for your local line voltage.

6. Only use fuses of the type and current rating specified. Do not use 
repaired fuses and do not short-circuit the fuse holder.

7. The supplied power cord must be inserted into a power outlet with a 
protective earth contact (ground). When using an extension cord, 
make sure that the cord also has an earth contact.

8. Do not change the external or internal grounding connections.
Tampering with or disconnecting these connections could endanger 
you and/or damage the system.

Caution The instrument is properly grounded in accordance with 
regulations when shipped. You do not need to make any changes to the 
electrical connections or to the instrument’s chassis to ensure safe 
operation. ▲

9. Never run the system without the housing on. Permanent damage 
can occur.

10. Do not turn the instrument on if you suspect that it has incurred 
any kind of electrical damage. Instead, disconnect the power cord 
and contact a Service Representative for a product evaluation. Do 
not attempt to use the instrument until it has been evaluated. 
(Electrical damage may have occurred if the system shows visible 
signs of damage, or has been transported under severe stress.)

11. Damage can also result if the instrument is stored for prolonged 
periods under unfavorable conditions (e.g., subjected to heat, water, 
etc.).
viii XSERIES 2 Getting Started Guide Thermo Fisher Scientific



Read This First
Safety and EMC Information
12. Always disconnect the power cord before attempting any type of 
maintenance.

13. Capacitors inside the instrument may still be charged even if the 
instrument is turned off.

14. Never try to repair or replace any component of the system that is 
not described in this manual without the assistance of your service 
representative.

15. When leaving the system, make sure, that all protective covers and 
doors are properly connected and closed, and that heated areas are 
separated and marked to protect for unqualified personnel!

16. Do not dismantle the pump head. There are no serviceable parts 
inside. Warranty will be void if the pump has been opened.

17. Particulate material present in the samples can cause serious damage 
to the XSERIES 2. Ensure that your samples do NOT contain any 
particulate material before using them with the XSERIES 2.

18. Prolonged exposure to mineral acids at concentrations above 10% 
can cause degradation of the material used in the XSERIES 2's high 
precision piston pump. Avoid the use of samples containing high 
concentrations of mineral acid if possible; otherwise, ensure that you 
wash the XSERIES 2 with clean water between each measurement 
and at the end of the analysis.
Thermo Fisher Scientific XSERIES 2 Getting Started Guide ix
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Chapter 1  Optimizing the Signal

Objective

This exercise will lead you through the first basic operational steps from 
switching the instrument on, obtaining the first signal and optimizing 
the instrument.

This chapter treats the following steps:

• “Step 1 - Instrument Pre Startup Status” on page 1-1

• “Step 2 - Switching on the Instrument” on page 1-2

• “Step 3 - Configuration Setup” on page 1-2

• “Step 4 - Accessories Control” on page 1-3

• “Step 5 - Optimizing the Signal Manually” on page 1-4

• “Step 6 - Autotune Procedure” on page 1-8

Step 1 - Instrument
Pre Startup Status

Perform the following checks before switching the instrument into 
operational state:

1. Ensure that glassware and cones are in position.

2. Check that the peristaltic pump tubing is in good condition and 
that tubing is clamped.

3. Ensure that the Faraday cage is in its forward position and that the 
Faraday cage door is closed.

Solution required for this practical

10 ppb tuning solution (Li, Be, Bi,
Ce, Co, In, Ba, Pb, Tl, U) in 2%
HNO3.
Thermo Fisher Scientific XSERIES 2 Getting Started Guide 1-1



Optimizing the Signal
Step 2 - Switching on the Instrument
Step 2 - Switching on
the Instrument

During the sequence, the sample introduction system is purged with 
argon. The neb gas is then switched off before the RF power is started 
and the ICP ignited. The interface valve is opened, and the slide valve 
separating the interface from the high vacuum region is opened (this 
occurs when the expansion pressure has reached less than 3 mbar). Once 
On, check the Peltier chiller temperature (if required).

Step 3 - Configuration
Setup

2. Open the Configuration page, which displays the Configuration 
Editor. From this page, the correct configuration can be selected.

Configurations are usually set up for different sample introduction 
setups, that is Autosamplers, Low flow nebulizers, Laser Ablation, 
USN6000 etc.

The Accessories and Devices that are to be used can be selected by 
ticking the appropriate box or setup using the accessory wizard.

The instruments settings can be selected here, if a particular set of 
tuning parameters is required, or left unticked, if the current 
instrument settings are to be used.

3. Click on New Configuration, if different settings other than default 
or those already displayed are required. The Description is editable in 
order to indicate which options are being used. Each configuration 
has its own related tune settings which when saved appear under 
Instrument settings. Click on the required configuration to use it.

1. Click once on the On button. The instrument will pass 
automatically through the start-up cycle which lasts approximately 
90–120 s.

1

1. Click on the Instrument icon to open up the instrument control.
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Optimizing the Signal
Step 4 - Accessories Control
4. Click on Accessories Wizard, if a required accessory is not available 
for selection. The wizard will guide you through the selection and 
configuration of new accessories.

5. Tick the Use box on the Available Accessories and Devices to select 
which accessory is to be used for future experiments (that is, if an 
autosampler is selected here, when a new experiment is opened, it 
will automatically configure the experiment for autosampler sample 
positions).

Step 4 - Accessories
Control

Use the standard tuning solution containing 10 ppb of Li, Be, Co, In, 
Ba, Ce, Pb, Bi, Tl and U. Place the sample uptake tube into the 1 ppb 
tune solution and ensure that the solution is taken up smoothly. Ensure 
that the solution uptake and the drainage are working correctly.

1. Click on Tune page in the instrument section.

2. Ensure that Pulse Counting is selected for Real Time Display.

3. Click on the Accessories window in the Tune page to display the 
Accessories control.
The peristaltic pump or autosampler can be initialized and pump 
speeds optimized. Also autosamplers can be manually set to go to 
different positions from here, if required, e.g. to send the 
autosampler to the tune solution via an autosampler position.

3
4

5

3

1
2
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Optimizing the Signal
Step 5 - Optimizing the Signal Manually
Step 5 - Optimizing
the Signal Manually

You can optimize the signal either manually or automatically. Usually 
the Autotune option is used, but it is good practise to be familiar with 
the manual tuning process, which will be explained briefly. Optimize for 
the highest sensitivity while obtaining low levels of oxides and doubly 
charged species.

1. Click on Tune in the Instrument section, which is already open. 
Otherwise, click on the Instrument icon to open this section.

2. Click on the Hide/Show button to either hide or show the manual 
slide controls. For users who only use the Autotune functions, the 
manual slider controls are usually hidden. The setting of the 
Hide/Show button is remembered on a per user basis from the 
Windows logon.

3. Click on Major. These parameters are the most common ones for 
tuning and have the greatest effect on signal stability and sensitivity.

4. Click here to start the Real Time Display (RTD).

5. Use the slider to select the default settings as shown. The large button 
is the slider bar to change the voltage setting. The small reset button 
underneath the slider resets the voltage to the last saved setting. The 
red color underneath the slider indicates the voltage region which 
should not be used, the yellow indicates caution and the gray range 
is the recommended settings for voltage tuning. Gently drag the 
slider by moving the mouse pointer to the gray rectangle, and while 
holding down the left button, move it along.

2
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Optimizing the Signal
Step 5 - Optimizing the Signal Manually
The voltage will be changed when the slider is released. Assuming that 
the torch is generally centered on the sample cone, start with D1, 
followed by Extraction, Lens 1, Focus, then Pole Bias, monitoring how 
the signal changes with each adjustment. Continue adjusting each of the 
lenses in sequence, until the optimum signal has been obtained. Click in 
the light gray region for coarse tuning and the arrows at the ends of the 
slider bar for fine tuning.

Note The figure below shows the default settings. ▲

2
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Optimizing the Signal
Step 5 - Optimizing the Signal Manually
6. Click on Minor for fine adjustment of the tuning. The horizontal 
and vertical positions of the torchbox might need re-positioning 
slightly when using different torch types or if the torch has been 
replaced.

7. It is possible to change the masses to be displayed in the RTD at any 
time. Select the masses Co59, In115 and Bi209 by selecting the 
Enable check box next to their mass. To change the monitored 
masses, click into the Symbol field and then on the downward 
arrow, which will display a periodic table. Select the analyte or 
interference you wish to monitor from the periodic table.

1

2
3

4

5
5
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Optimizing the Signal
Step 5 - Optimizing the Signal Manually
8. Enter a Dwell time of 100 ms. Drag and drop can be used to fill 
down.

9. Select CeO (156) and Ce++(70) as Numerators ratioed to Ce(140) as 
Denominator, to monitor the oxide and doubly charged species levels 
(levels of < 2% CeO and < 3% Ce++ are acceptable).

Note These must first be added to the mass list before Numerator and 
Denominator can be selected. ▲

10. Monitor the masses selected in the RTD. When tuning the ion 
optics, a decrease and increase of the signal in CPS can be observed, 
when changing the voltage to the lenses. Tune for the maximum 
sensitivity, while obtaining a flat mass response across the whole 
mass range. Ensure that the oxides and doubly charged species do 
not exceed the acceptable levels. The responses measured depend on 
the interface type used and the mass monitored (that is, Be does not 
ionize as well as Li and therefore will not be as sensitive).
Thermo Fisher Scientific XSERIES 2 Getting Started Guide 1-7



Optimizing the Signal
Step 6 - Autotune Procedure
11. In the Global tune page, the settings for the resolution and detector 
voltages are displayed. This needs to be changed seldom, as for most 
purposes the resolution is factory-set and the detector voltages can 
be set up automatically using the instrument calibration wizard (see 
Chapter 3: “Instrument Calibrations”.

12. Save the optimized parameters.

Step 6 - Autotune
Procedure

The Tune page contains a further icon to perform the Autotune. This 
function replaces the manual tuning procedure explained in “Step 5 - 
Optimizing the Signal Manually” on page 1-4. The Autotune procedure 
is fully user-definable to allow tuning for specific application needs. A 
list of Autotune procedure templates is supplied in the software and each 
procedure indicates which tuning solution should be used.

The Autotune procedure is subdivided into different stages. For each 
stage individual minimum and maximum criteria can be defined.

1. The Autotune can be started manually by clicking on the Start the 
Autotune Wizard icon.

11

12

1
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Optimizing the Signal
Step 6 - Autotune Procedure
2. Click on either the Autotune icon or the arrow next to it. Both will 
initiate the autotune wizard. The autotune wizard will now guide 
you step by step through the procedure. Click on Next after each 
step.

3. This page allows you to select an existing Autotune sequence and if 
more than one version of the sequence exists, a specific version.

Select the sequence from the list which suits your current application 
and configuration. E.g. a higher sensitivity specification for the high 
mass end and/or lower oxide levels could be defined for specific 
applications.

2

Click on Run an

Autotune se-

quence.

Alternatively you can

edit existing se-

quences or create a

new user-defined

sequence.
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Optimizing the Signal
Step 6 - Autotune Procedure
Each Autotune sequence is listed as a folder. Clicking on the + sign next 
to the folder will list the archived versions of the Autotune sequence. 
The green tick mark shows the currently active version of the sequence. 
Clicking on the folder will automatically select the currently active 
version. To select any of the archived versions, expand the folder and 
click on the required version.

The text box on the right of the page shows the description of the 
currently selected sequence.

If the wizard is being used to run a sequence, pressing the Next button 
will show the stage ordering for the Autotune sequence allowing the user 
to confirm that this is the correct Autotune sequence to use.

3
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Optimizing the Signal
Step 6 - Autotune Procedure
The detailed steps of the Autotune sequence are listed. This page allows 
the user to review the order and contents of the stages for the Autotune 
sequence before running and editing it. Each Autotune stage is listed as 
a folder.

The user can choose to introduce the sample manually or via the 
autosampler. If the autosampler is selected, the rack, row, column and 
height of the tune solution can be specified.

4

5

.
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Optimizing the Signal
Step 6 - Autotune Procedure
4. For each sequence, a tuning solution is recommended, which you 
should aspirate.

5. Click on Next to start the Autotune.

6. The progress of the Autotune process is displayed in-situ in the 
dialog box. The Autotune process can also be viewed in the Real 
Time Display. A full Autotune procedure will take approximately 
10 min. The range for each parameter can be pre-defined by the 
user or by the default template. By editing the parameters 
appropriately, the duration of the Autotune process can be 
shortened.

The Autotune script selected for this example is divided into three 
stages:

Stage 1: It will optimize the horizontal and vertical position of the torch 
while maximizing the In signal.

Stage 2: It will then optimize all the lenses one at a time, while 
maximizing the signal for a defined mass.

Stage 3: Tuning the nebulizer gas flow. It will go through maximizing 
the signal as well as minimizing the oxides at the same time.
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Optimizing the Signal
Step 6 - Autotune Procedure
Note It is recommended that you create an Autotune update sequence 
once the instrument is fully optimized. This option generates a new 
sequence that uses the new parameters as the default setting and 
automatically narrows the range over which each parameter is adjusted. 
Thus, the Autotune time can be significantly reduced. An update is 
created automatically, if the sequence has the Create Update check box 
marked at the end of the editing process. ▲

During torch optimization, the In signal is tuned for maximum 
sensitivity.

During the horizontal alignment procedure, the torch is changed 
between pre-defined settings. 

6
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Optimizing the Signal
Step 6 - Autotune Procedure
While the torch is moved between the horizontal pre-defined positions, 
the In signal is plotted over time. The software will then define the 
horizontal position, where the maximum signal was determined.

While the nebulizer gas setting is changed, not only In is monitored for 
maximum sensitivity, but also the CeO/Ce ratio (blue line) is monitored 
in order to minimize it.

When tuning the nebulizer gas flow, the effect is only visible in the RTD 
after approximately 5 s, due to the time taken for the nebulizer back 
pressure to adjust. For this reason, a default setting change is set in the 
software between each change in the gas flow rate.

The RTD display can show both the analyte signal (black) and the 
CeO/Ce ratio (blue). The nebulizer gas flow is slowly increased or 
decreased and the effect on the analyte and oxide signal can be 
illustrated in the RTD display.

7. Once the Autotune procedure is completed, an Autotune report is 
generated which shows the chosen setting as well as the results for 
each stage of the tuning process. The Autotune report can be 
printed by simply clicking on the Printer icon. In this example, all 
set criteria were passed. If any criteria were not passed, it would be 
highlighted in red. The three stages torch position, lenses and 
nebulizer are listed as well as the analytes and/or oxides monitored.
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Optimizing the Signal
Step 6 - Autotune Procedure
As can be seen, during stage 1, (torch position) only the In signal was 
optimized, whereas during stage 2 (lenses), the signal was optimized for 
Be, In and U. In stage 3 (nebulizer), the sensitivities for the three 
analytes were monitored, while the CeO/O ratio was minimized.

8. After completion, the settings found during the Autotune procedure 
are automatically saved in the Configuration page.

PlasmaLab allows you to view the results of successful Autotune 
sequences. Right mouse clicking on the instrument settings grid on the 
Configuration page will bring up the following menu.

The top menu item View Autotune report only appears for settings that 
have a User of Autotune. Selecting this menu item will bring up a dialog 
showing the stage by stage progress of the Autotune sequence used to 
create the settings.

7

Printer icon

8
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Optimizing the Signal
Step 6 - Autotune Procedure
To print this report, click on the Printer icon, or click on the Print 
Preview button to preview what the print will look like.
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Chapter 2 Initial Performance Checks

Objective

To set up a short term stability test with monitoring the oxides and 
doubly charged species as isotope ratios. This is the daily checking 
routine prior to commencing the analysis of unknowns. A survey scan is 
also performed to check for good peak shapes and check mass 
calibration and peak resolution.

This chapter treats the following topics:

• “Step 1 - Creating a New Experiment” on page 2-2

• “Step 2 - Experiment Setup” on page 2-3

• “Step 3 - Setting Acquisition Parameters” on page 2-6

• “Step 4 - Isotope Ratio Selection” on page 2-7

• “Step 5 - Creating Sample List” on page 2-8

• “Step 6 - Running Performance Report Test” on page 2-9

Short term stability experiments can provide a great deal of useful 
information on the performance of your instrument. They should be 
undertaken as a daily checking routine every morning after optimizing 
the instrument, and to archive the data so that day to day performance 
can be monitored.

The short term test lasts only 10 min. and should be undertaken as part 
of the standard startup routine by all users. The instrument should be 
allowed to stabilize for 15 min. after starting up before attempting the 

Solution required for this practical

10 ppb tuning solution (Li, Be, Bi, 
Ce, Co, In, Pb, U)
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Initial Performance Checks
Step 1 - Creating a New Experiment
short term stability test. A Survey Scan can be performed as part of this 
test to give a great deal of useful information about peak shapes, 
resolution and mass calibration.

Step 1 - Creating a
New Experiment

2. In the experiment wizard, click on Create a new blank experiment.

3. You are automatically prompted to choose a database.
Select Default.tea as the analyte database for this experiment.

1. Click on the Experiment icon.
1

2
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Step 2 - Experiment Setup
Step 2 - Experiment
Setup

1. If the Setup pages are not displayed, click on the Setup tab to show 
them.

2. Click on the Configuration Editor to select the correct 
configuration for the experiment.

3. By default, the ICP-MS will use the current configuration and tune 
settings, which are shown in purple. If different conditions are 
required, select the correct configuration for the experiment by 
ticking the Use box. The software will now display the selected 
configuration in purple. By selecting a configuration for an 
experiment, it allows multiple experiments to be queued with 
different conditions.

3

1

2

Thermo Fisher Scientific XSERIES 2 Getting Started Guide 2-3



Initial Performance Checks
Step 2 - Experiment Setup
4. The Accessories used with this configuration are shown. Should these 
be incorrect, the configuration will need to be edited in the Main 
Instrument Section of the software before continuing.

5. The instrument settings box can remain unticked, if only one set of 
instrument settings is being run. This will enable the experiment to 
use the last set of saved instrument settings.

If different settings are used (that is, Standard mode and 
PlasmaScreen mode), the relevant instrument settings should be 
ticked in each experiment.

6. Click on the Timings tab to set up the sample introduction timings. 
Select the Uptake time for the time taken for the sample to reach the 
plasma and Washout times as shown above. Monitored uptake and 
wash will allow masses to be used to automatically determine when a 
sample has been introduced or washed out. Consult the online help 
for further information on this function.

7. Click on the Analyte tab. Select the following analytes by double 
clicking to select the default isotope: Li, Be, Co, In, Ce, Pb, Bi, U 
and Bkg.

The masses Bkg and Ce are monitored for checking the background 

3

4

6
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Initial Performance Checks
Step 2 - Experiment Setup
noise, oxides and doubly charged species. The other analytes are 
monitored for the short term stability test.

8. Click once on Bkg to manually select the masses 5 and 220 in order 
to monitor the background noise for the low and the high mass. 
Two blue dots will now appear for Bkg, indicating that two isotopes 
have been selected.

9. To monitor the doubly charged species, select Ce++ from the 
polyatomic list and select 140Ce++.

10. To monitor the oxides, select CeO from the polyatomic list and 
select 156CeO.

7

8

9
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Step 3 - Setting Acquisition Parameters
Step 3 - Setting
Acquisition
Parameters

1. Now the Acquisition parameters can be defined. Select from the 
experiment section: Setup.

2. Select Acquisition parameters.

3. Select Survey Run (light gray when selected).

4. Select the main run to be Peak jump. This will just run the 
elements selected in the analyte menu.

5. Enter the same value for the number of Sweeps as shown above.

6. Select the Start and End Mass for the skip regions and Dwell time, 
Channels per AMU as shown for the Survey run. These parameters 
only become available when the Survey run has been selected. The 
Acquisition time will be automatically calculated. The survey run is 

10

1
2

3 4
5

6

7

8
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Initial Performance Checks
Step 4 - Isotope Ratio Selection
always performed in Scanning mode. The parameters shown are 
default and should already be present.

7. For the Main Peak jump run, select the number of sweeps to be 110.

8. As the Main run is normally performed in Peak Jumping mode, the 
number of Sweeps, Dwell time and Channels per AMU are different 
to the survey run.

Enter the Dwell times for the analytes previously defined in the 
element menu. Use a Dwell time of 30 ms for the analytes, oxides 
and doubly charged species and 100 ms for the background masses. 
The acquisition time will be automatically calculated. It should be 
approximately 60 s for a short term stability test.

Step 4 - Isotope Ratio
Selection

1. To define the Isotope Ratios, click on Setup and Isotope Ratio.

2. The ratios for the oxides and doubly charged species can now be 
defined. Click on the downward arrow to display the list of analytes 
to choose the Numerator and Denominator.

3. After selecting first the Numerator and then the Denominator, click 
on the Add ratio button.

4. After clicking the Add ratio button, both analytes will be displayed 
in the table. Select the ratios as shown below for Ce++/Ce and 
CeO/Ce. If a ratio is incorrectly added, it can be removed by 
clicking the gray box next to the ratio in the grid and press the 
Delete ratio button.

12

3

4
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Step 5 - Creating Sample List
Step 5 - Creating
Sample List

1. Now the sample list can be defined. Click on Sample List and then 
again Sample List.

2. Enter all fields as shown below. The Survey Run will be used to check 
the mass calibration and peak shapes for the full mass range. Then 
the ten Main Runs will be used for the short term stability test.

1

2

3 3. It is recommended to build up a 
library of templates for routine 
analysis types, e.g. for tuning, short 
term stability test etc.

To create a template at any stage of 
building an experiment or even post 
acquisition, choose the File > Save 
As Template option when the 
experiment is open.

4
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Initial Performance Checks
Step 6 - Running Performance Report Test
4. File Save as Template, file name “Survey and stabilities”.

6. When the sample list is complete, click on the Experiment Queue 
button to start the Acquisition.

Step 6 - Running
Performance Report

Test

The Tune page contains two further icons to either perform the 
Autotune (a) or to start the performance report wizard (b). Those two 
functions replace the manual tuning procedure and the short term 
stability test as explained in the earlier steps of this practical.

The Autotune and performance report functions are designed to replace 
the manual tuning procedure and the short term stability test. A 
user-defined performance report can be set up similar to the short term 
stability test, in which the user will define the daily performance 
specifications for the instrument. If the criteria are met, the instrument 
is ready to commence sample analyses. If the criteria are not met, an 
Autotune must be performed after verifying that all other possible 
sources of the performance test failure have been excluded.

5

5. The list of templates available can be viewed by 
clicking on Template at the lower left corner of 
the screen. The currently defined templates will 
be shown.

To perform the short term stability test in the 
future, click on Template at the lower left corner 
and select Survey and stabilities.

Alternatively, click on the Experiment icon, 
create an experiment from a template and select 
Survey and stabilities.tet. It is also possible to 
add extra samples or analytes to the original 
experiment, if desired.

6

f f

1

a b
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Step 6 - Running Performance Report Test
The performance report is a user-definable procedure, although the 
software is supplied with pre-defined examples. It is generally set up to 
run a short term stability test, in which the user can define the pass/fail 
criteria. These criteria could entail different sensitivity specifications for 
the analytes, RSD limits, and/or limits on oxide levels, doubly charged 
species, background counts etc. These limits can be set to either 
minimum or maximum values.

The user can specify the action to be taken, if any of the criteria are not 
met. The user can also define what analytes to analyze in the short term 
stability test, which could be the tune solution or it could contain 
analytes closer to the analytes in the samples. After the analysis, the 
software will evaluate the pass criteria.

If it passes, the user can carry on with the analyses of standards and 
unknown samples. If it fails, the Autotune procedure should be 
performed. If this passes, the performance test should be repeated.

The performance report and Autotune routines can be fully automated 
in an experiment. Refer to the online help for further information about 
this option.

1. After the instrument has been switched on and has warmed up, click 
on the icon for the Performance Report, and a wizard will 
automatically open up. The toolbar button provides access to the 
Performance report configuration and execution functions. Clicking on 
the icon starts the performance report acquisition wizard.

The first item in the menu allows the user to start the performance 
report acquisition wizard, which is the same action as clicking on the 
toolbar button. Up to eight of the last Performance reports that 
have been run are listed at the bottom of the menu. Clicking on one 
of these items will start the currently active version of the 
Performance report.

2. Follow the steps of the performance report wizard as shown below. 
Click on Acquire a Performance Report. Click on Next after each 
step.
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Step 6 - Running Performance Report Test
3. Select the report that matches your configuration from the list. If no 
report suitable for your configuration is available, cancel the wizard 
and either edit an existing report or create a new one at the start of 
the performance report wizard.

Each Performance report is listed as a folder. Clicking on the + sign next 
to the folder will list the archived versions of the Performance report. 
The green tick mark shows the currently active version of the report.

Clicking on the folder will automatically select the currently active 
version. To select any of the archived versions, expand the folder and 
just click on the required version. The text box on the right of the page 
shows the description of the currently selected report.

2

3
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Initial Performance Checks
Step 6 - Running Performance Report Test
.

4

5

6

4. Select whether 
you wish to 
introduce the 
sample manually 
or via the 
autosampler.

5. Load the sample 
and click on 
Next to start the 
performance 
report sample 
update.

6. The 
performance 
report 
acquisition 
wizard displays 
every step of the 
process, e.g.  
uptake delay in 
seconds.
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Step 6 - Running Performance Report Test
8. The results of the performance report acquisition wizard are 
displayed. In this example, the criteria were not met, and the 
performance validation has failed. The wizard will list possible 
explanations for the failure.

Note If the correct solution and performance report for the current 
instrument configuration were chosen, it is recommended to re-tune the 
instrument. ▲

This is the final page for the performance report wizard. Clicking on the 
Finish button will finish the wizard. The View Report button will 
display the report and allow it to be printed. This report can also be 
viewed using the View Performance Report Results of the menu of the 
Performance Report button.

The Save Log File button allows the progress of the performance report 
to be saved to a file for diagnostic purposes, if a failing performance 
report test needs troubleshooting.

9. The performance report is automatically displayed. The tuning 
parameters are listed at the top of the page. The report can be printed by 
clicking on the Print icon.

7

8

7. After the uptake 
delay, the 
acquisition 
process is shown 
in detail.
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Step 6 - Running Performance Report Test
In this example, some of the criteria failed, such as the sensitivity 
specification, as well as the oxide level. The failed criteria are highlighted 
in red.

Note Generally, the performance test will be passed first time. It is then 
possible to commence with the sample running immediately 
afterwards. ▲

Note It is also possible to run the Autotune prior to the performance test 
by clicking its icon. ▲

PlasmaLab allows you to view the results of performance reports that are 
acquired from the Instrument Tune page. Selecting the View 
Performance report results menu item from the Performance reports 
drop down menu shows the following dialog.

Each performance report result is listed in the list window. Clicking on 
the header of each column will sort that column, toggling between 
ascending and descending for each click.

To select a result to view, click on the name in the list. If you wish to 
view more than one result, hold down the Ctrl key whilst using the 
mouse to click on each of the required results in the list.

9All failed criteria are highlighted in red.
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Chapter 3 Instrument Calibrations

Objective

This section will take you through all steps of instrument calibration. 
The XSERIES 2 ICP-MS periodically needs to be calibrated for 
optimum performance. The instrument calibration wizard allows you to 
adjust the mass calibration, as well as the detector calibration to ensure a 
good wide dynamic range with a cross calibration of the pulse counting 
and analog modes of the detector.

This chapter treats the following topics:

• “General Remarks” on page 3-1

• “Step 1 - Detector Calibration” on page 3-2

• “Step 2 - Mass Calibration” on page 3-9

• “Step 3 - Detector Monitoring” on page 3-13

General Remarks There are two types of calibration routines to be performed on a regular 
basis:

• Detector calibration and

• Mass calibration

These calibrations are made through the instrument calibration wizard 
in the Instrument section or an experiment using an instrument setup 
sample. Whenever an instrument setup sample is analyzed, the data is 
always copied back to the instrument database for subsequent 
experiments to use as well as a copy being kept in the experiment itself.

The Instrument Calibrations page also shows the Detector Monitoring 
page which allows the user to track the lifetime of the detector currently 
installed. For each new detector, a new lifetime dataset is created as well 
as a new section for the detector calibrations.
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Instrument Calibrations
Step 1 - Detector Calibration
The sample used for the detector setup wizard needs to be a 
multi-element solution which meets the following criteria:

• At least one analyte peak between masses 100-140 amu must have a 
count rate between 500,000 and 2,000,000 cps. This may be a 
minor isotope that is not normally used for measurement in an 
experiment (that is, 117Sn). The software will use as many peaks as 
it can between 100 and 140 amu to set up the voltage on the analog 
detector section. It will normally use more than one peak, but unless 
it can find one peak that meets the criteria, the calibration will fail. 
An appropriate message will be given in the wizard dialog.

• If possible, all the analyte elements that are to be measured using 
analog mode for any part in the experiment should be present in the 
solution with count rates exceeding 500,000 cps. It does not matter 
if any (or most) of the peaks exceed the maximum count rate 
allowed for the pulse counting detector section, as the software will 
automatically detect this during the calibration and use points at the 
side of the peak to perform the cross calibration.

• To ensure a reasonable interpolation of the cross calibration when 
no analytes are present in a mass range, it will be better, if both very 
low mass and very high mass analytes are present at count rates 
exceeding 500,000 cps in the calibration solution.

Step 1 - Detector
Calibration

The XSERIES 2 ICP-MS can operate over a wide dynamic range, 
allowing the user to analyze trace, minor and major element 
concentrations. Trace elements produce very low signals, which in turn 
require a large amount of amplification. These elements are detected in 
the pulse counting part of the detector. Large concentrations are 
measured with the detector operating in analog mode.

In order to achieve a continuous and wide dynamic range, the pulse 
counting and analog acquisition modes operate together.

Note It is important to have the correct correlation between the two 
modes of operation to ensure continuity over the complete dynamic 
range. The correlation between pulse counting and analog detection is 
mapped by the detector cross calibration. ▲

Solutions required for instrument 
calibration

It is recommended to use a ME 
solution in the 50-100 ppb range, 
containing low, mid and high mass 
elements.
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Instrument Calibrations
Step 1 - Detector Calibration
A conversion factor is calculated for each of the valid masses. This is 
used to calculate a polynomial equation which is then used to generate a 
lookup table of correction factors for each integer mass over the whole 
mass range. Before being stored in the experiment and the instrument 
database, for any masses where a factor has been measured, the lookup 
table is replaced by the measured value.

As the instrument calibrations are automated procedures, the user is not 
required to input any analyte information. The software automatically 
detects the analytes present in the solution and chooses the most 
appropriate ones to use.

The detector calibration software is designed to work with solutions that 
have high analyte concentrations which collect data in the analog 
detector mode. The software will automatically measure points at the 
side of a peak which trips the detector gate at its maximum.

The instrument calibration wizard will perform all the steps necessary to 
set up the detector.

1. Click on Set up the detector. A dialog will open to present the user 
with options to perform a calibration between the pulse counting 
and analog detector modes (cross calibration) or to fully set up the 
detector voltages and then do a cross calibration. Click on Next.

1
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Instrument Calibrations
Step 1 - Detector Calibration
2. The user can either present the solution manually or via the 
autosampler.

3. Click on Next to start the sample uptake.

1

2
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Instrument Calibrations
Step 1 - Detector Calibration
Start the calibration process by pressing the Next button. This will give 
a sample uptake timer which can be paused, if required. To begin the 
calibration before the timer completes, press the Next button. During 
the data acquisition for the detector calibration, the wizard will show the 
steps being undertaken whilst the Real Time Display will show the 
actual data acquired.

3

4

4. First the 
pre-scan is 
started, 
followed by 
the main 
acquisition.
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Instrument Calibrations
Step 1 - Detector Calibration
6. Enter a filename to save the instrument calibration log file.

7. The Detector Cross Calibration can be viewed in the Instrument 
section.

.

5

5. Upon a 
successful 
completion, 
click on Save 
Log File or 
click on 

6
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Instrument Calibrations
Step 1 - Detector Calibration
The detector cross calibration is used to convert the data acquired using 
the analog detector mode into the equivalent pulse counting data. The 
results of a successful calibration are shown on the Detector Cross 
Calibration page. This page is shown in both the experiment and the 
instrument views.

The current cross calibration is shown in bold at the top of the tree-list. 
If a new detector has been fitted, the old cross calibrations are archived 
under the “old calibrations” part of the tree. To view a cross calibration 
graph and its data, click on the date and time for the calibration in the 
list.

The graph shows the measured data points with error bars showing the 
+/- acceptable errors from the calculated curve. The raw data for each 
point can be seen by clicking on the point in the graph or on the row for 
a measured analyte in the table.

8. Before queueing the experiment, aspirate an appropriate solution 
(see solution required).

8

9. To view the results of the detector calibration, click on the 
Instrument icon.

9
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Instrument Calibrations
Step 1 - Detector Calibration
10. Select Calibrations and Detector Cross Calibration. Click on the 
detector cross calibration that has just been performed, shown by 
the date and time stamp.

11. The graph will show the calculated cross calibration factor for each 
mass found on the y-axis against the mass on the x-axis. A 
polynomial fit will be applied through the enabled points. The cross 
calibration factor should be approximately 20,000–40,000 at mid 
mass.

Note A non-matching cross calibration point can be viewed and edited 
by clicking on the point. All the values used to determine the point are 
shown, and the values can be edited to improve the fit, if required. More 
information is available in the online help. ▲

Alternately, the detector calibration can be performed via the instrument 
setup sample.

1. Click on Sample List > Sample List in an Experiment.

2. Enter a sample Label for the detector cross calibration.

3. Click in the Type column and then on the downward arrow and 
select Instrument Setup.

p

10
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Instrument Calibrations
Step 2 - Mass Calibration
4. Click on Show Advanced to view the Advanced Properties.

5. To perform a detector calibration, check the appropriate box.

Note More diagnostic information on calibration is provided by using 
the instrument calibration wizard rather than the Instrument Setup 
Sample in an experiment. ▲

Step 2 - Mass
Calibration

The software uses a mass calibration equation so that when a mass is 
selected for measurement, the control electronics can set the quadrupole 
to transmit that mass. The mass calibrations are stored such that any 
experiment can access them when the experiment is being run.

PlasmaLab uses the following default set of acquisition parameters for 
the mass calibration:

PlasmaLab converts the mass ranges into DAC values using the 
currently selected mass calibration. These parameters are then sent to 
the instrument which acquires 10 sweeps.

1

2 3

4

5

Acquisition Parameter Value

Dwell 1000 µs

Channels per AMU 20

Scan Regions 4.5 to 10.5

23.5 to 27.5

50.5 to 78.5

81.5 to 245.5
Thermo Fisher Scientific XSERIES 2 Getting Started Guide 3-9



Instrument Calibrations
Step 2 - Mass Calibration
A mass calibration set comprises the mass calibrations for both the 
standard and high resolution quadrupole modes which are automatically 
done at the same time by the mass calibration wizard or as part of an 
Instrument Setup Sample in an experiment. Follow the mass calibration 
wizard step by step.

1. Click on the Instrument Calibration Wizard icon, then on Mass 
calibrate the quadrupole.

1
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Instrument Calibrations
Step 2 - Mass Calibration
The mass calibration can be viewed in Instrument > Calibration > 
Mass Calibration.

The quadru-

pole resolu-

tion at which

the data was

acquired.

The date and time

at which the data

was acquired.

These are the 3 coefficients

calculated by applying a

second order polynomial fit to

the data that has been ac-

quired.

A space to enter

notes relating to the

calibration.

The mass

of the

analyte

where a

peak was

found.

The digital value at

which the centre of

the peak was found.

The width of the peak

in Atomic Mass Units

at 10% of the peak

maximum.

The difference between

where the centre of the

peak was found and where

it is calculated that it should

be found using the polyno-

mial line fit.

Whether or not

to include the

point in the

calculation for

the polynomial

fit.
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Instrument Calibrations
Step 2 - Mass Calibration
The top grid lists all of the mass calibrations that have been successfully 
acquired and calculated. Clicking the right mouse button on the grid 
will show a menu that allows a mass calibration to be set as the current 
one.

The current mass calibration set is highlighted in green in the top grid. 
Clicking on any row will show the data for the mass calibration in the 
lower grid and the relevant graph.

The graph will show the peak width and error between the found peak 
center and the calculated peak center on the y-axis against the mass on 
the x-axis for each mass at which a peak has been found.

Data points can be included or excluded by either clicking on the point 
on the graph or changing the state of the include box for the mass in the 
lower grid.

Every time an experiment is queued, the current mass calibration as 
selected in the instrument view is copied from the instrument database. 
The top grid lists all of the mass calibrations that have been copied into 
the experiment. Clicking the right mouse button on the grid will show a 
menu that gives the option to import a mass calibration from the 
instrument database and to apply a mass calibration to all of the data in 
an experiment.

Instrument setup samples can be placed anywhere in the sample list and 
they can also have repeat rules applied. However for most applications, 
only one will be required at the start of the experiment. The data 
collected by an instrument setup sample for the instrument calibrations 
or Autotune is also copied to the instrument database for use by 
subsequent experiments.
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Instrument Calibrations
Step 3 - Detector Monitoring
The Instrument Setup for the Instrument Setup Sample is divided into two 
parts: the first enables the mass calibration and detector setup, whereas 
the second part enables the performance report and Autotune.

Once the calibrations have been completed, the data can be viewed 
either in the experiment that has just used the Instrument Setup Sample 
under the Instrument Calibrations tab, or a complete list of all 
calibrations can be viewed in the Instrument section of the software 
under the Calibrations tab.

Step 3 - Detector
Monitoring

After a new detector has been installed and the automatic outgas 
procedure has been completed (see Chapter 7: “Maintenance”), the 
detector will be monitored throughout its lifetime. The Detector 
Monitoring page will show the information for the new detector. The 
various parameters can be displayed using the Options on the right of the 
page.
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Instrument Calibrations
Step 3 - Detector Monitoring
The software will track various events during the lifetime of a detector 
for diagnostic purposes. The various parameters measured can be viewed 
on the Calibrations pages of the Instrument section. Should a detector 
lifetime issue arise, this information will be able to help track the cause 
of the problem.
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Chapter 4 Sample Analysis

Objective

The objective is to set up an experiment for the analysis of standards and 
unknown samples. Calibration graphs will be created showing the 
quantitative and semi-quantitative results.

This chapter treats the following topics:

• “Step 1 - New Experiment Creation” on page 4-2

• “Step 2 - Experiment Setup” on page 4-2

• “Step 3 - Acquisition Parameters” on page 4-5

• “Step 4 - Internal Standard Selection” on page 4-6

• “Step 5 - Calibration Method Setup” on page 4-8

• “Step 6 - Creating a Sample List” on page 4-9

• “Step 7 - View Data Acquisition” on page 4-11

• “Step 8 - Viewing Spectra” on page 4-11

• “Step 9 - Semi-Quantitative Results” on page 4-13

• “Step 10 - Fully Quantitative Results” on page 4-15

• “Step 11 - Printing Report” on page 4-20

Solutions required for this practical

• 2% HNO3 blank and unknown in 2% HNO3 matrix.

• A series of standards at concentrations of 5 ppb, 10 ppb and 
20 ppb from a tuning solution (e.g. CLMS-2) containing 
1 ppm of the following analytes: Li, Be, Co, Ni, In, Ba, Tl, Pb, 
Ce and U.

Add internal standard solution containing Ga, Rh and Bi at 
10 ppb.
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Sample Analysis
Step 1 - New Experiment Creation
Step 1 - New
Experiment Creation

2. From the Experiment Wizard select Create a new blank 
experiment. Select Continuous mode of operation.

3. You will be automatically prompted to choose a database. Select 
Default.tea as the analyte database for this experiment.

Step 2 - Experiment
Setup

1. In the selected new experiment click on the Configuration Editor 
in the Setup page to select the correct configuration.

2. Click on the Use box to select the standard default configuration, if 
not already selected.

3. Ensure that the correct accessories for the experiment are visible as 
shown (e.g. for a peristaltic pump for manual operation or an 
autosampler for unattended operation).

1. Click on the Experiment icon to open the Experiment Wizard.
1

2

1
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Sample Analysis
Step 2 - Experiment Setup
4. If an accessory is not shown for the experiment, it must first be set 
up using the Instrument icon and the Accessory Wizard in the 
Configuration Editor page.

This will help you to select and configure the available accessories, 
which will then be available when opening new experiments. The 
accessories are setup in the instrument and shown in the Experiment 
section only for reference purposes.

5. The Instrument settings box can remain unticked, if only one set 
of instrument settings is being run. This will enable the experiment 
to use the last set of saved instrument settings.

If different settings are used (that is, Cool Plasma and Hot Plasma 
mode), the relevant instrument settings should be ticked in each 
experiment. If not available, these can be set up and edited in the 
Instrument Control.

Note A Delay time can be inserted to allow the instrument to settle 
between settings. ▲

2

3

4
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Sample Analysis
Step 2 - Experiment Setup
6. Select the Timings tab in the Experiment Setup to select the Uptake 
time as the time taken for the sample to reach the plasma and 
Washout time, as appropriate.

Note Timings can be shortened considerably by the use of monitored 
uptake and wash (which can be selected here by ticking the Use 
Monitored check boxes and selecting a mass, such as the internal 
standard, whose signal can be monitored) and rabbit (fast pumping) on 
uptake and wash. The rabbit option is set in the Instrument section using 
accessory control language (ACL) scripts. See the online help about 
editing ACL scripts. ▲

7. To select the analytes which are required to be measured, click on 
Analyte on the Experiment Setup page.

8. Select all analytes required by double clicking the left mouse button 
on the analytes required. This selects the default isotope with the 
least interference. These default isotopes are setup in the analyte 
databases.

Alternatively, a single click will display a choice of isotopes which 
can be manually ticked for selection. The number of isotopes 
selected will be highlighted as dark blue dots above the analytes. The 
light blue dots automatically appear, if analytes are required for an 
interference correction equation.

Select all analytes that are required for use as internal standards. 
These will appear as yellow when selected as internal standards (see 

6
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Sample Analysis
Step 3 - Acquisition Parameters
step 4). To remove an analyte, use the right hand mouse button 
menu over the analyte in question.

9. To disable any interference correction equations not required, right 
hand mouse click on the row in the grid with the equation and 
choose the Disable Equation option.

Step 3 - Acquisition
Parameters

1. In Experiment Setup click on Acquisition Parameters to set up the 
survey and main run for the acquisition. The Main run selection can 
be either peak jump or scanning, depending on the application being 
run. The light gray areas show the selection made.

Survey can be performed on all samples as a backup to the Main run, 
from which semiquantitative data can be obtained. It can also be 
used to identify interferences. The Main run can be selected either 
as Peak Jump for best detection of a small number of isotopes (< 20) 
in the shortest time or as Scan for full spectral information.

2. The default parameters for the Survey are shown below. If required, 
the scan region can be adjusted by a right mouse click to add or 
remove scan regions on the mass scan graphic.

9

7

8

1
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Sample Analysis
Step 4 - Internal Standard Selection
Alternatively, the values in the numerical grid can be edited, and the 
changes will be repeated in the graphic.

3. The Main run Peak jump default parameters are shown below. Peak 
jump mode is the preferred method for fast acquisition with best 
detection. All the analytes selected in the Analyte menu will 
automatically appear in the symbol column.

4. If multiple tune settings have been chosen for the experiment, they 
can be associated with different analytes or scan regions here. The 
order of the settings and any stabilization times between tune sets is 
set up on the Configuration page of the experiment.

It is possible here to choose which of the quadrupole’s two Resolution 
settings are to be used for each analyte or region. Typically the 
resolutions are set to 0.8 and 0.4 amu at 10% peak height. The 
narrower peak (higher resolution) will improve interference removal 
for small peaks next to very large ones and will also extend dynamic 
range even further for high concentration analytes.

Step 4 - Internal
Standard Selection

1. In the Setup menu click on Internal Standards to select internal 
standards for the experiment.

Note It is recommended to select an internal standard at low, middle 
and high mass for a multi-element analysis. This ensures that any 
changes in response due to drift or matrix suppression/enhancement are 
compensated for. ▲

2
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Sample Analysis
Step 4 - Internal Standard Selection
Internal standards are selected that are (if possible) close in 
ionization potential to the analyte masses selected, near to 100% 
abundance and not present in the samples. To select an internal 
standard, these must be present in the Analyte menu for them to 
appear under the Symbol column.

2. To select an internal standard, highlight the required internal 
standard as shown above for Bi (Be and In have already been 
selected).

3. Click on the forward arrows to move the analyte across to the 
Internal Standard selected box on the right hand side.

4. Enter the concentration for the internal standard.

5. The default internal standardization method is Interpolate. 
Interpolate takes the response of two internal standards (that is, 9Be 
and 115In) and interpolates a linear response between the two 
masses. That is, if 9Be is 80% of its reference value and 115In is 90% 
of its reference value, then an analyte at mass 62 amu (Ni) would 
have an interpolated value of 85% for the correction.

By default, all internal standards are added to the profile for 
interpolation. It is possible to remove internal standards from the 
profile so they may be used only as reference points for specific 
analytes (e.g. 197Au for 202Hg correction). Even internal standards 
that are used in interpolation can also be used for specific references.

To specifically reference an internal standard to an analyte, choose it 
in the drop down menu in the Technique column.

1

2

3
4

Thermo Fisher Scientific XSERIES 2 Getting Started Guide 4-7



Sample Analysis
Step 5 - Calibration Method Setup
Step 5 - Calibration
Method Setup

1. From the menu, select Calibration Method. It is possible to select 
different calibration methods for each analyte.

4. In the right hand table under the Calibration Method menu, select in 
the Forcing column the option Through blank by clicking on the 
downward arrow to display the dropdown list. Select the Forcing 
method of choice for each isotope. The Through blank option is 
recommended.

5. Tick the boxes in the Semi-Quant column to select the isotopes that 
will be used to create the response curve. This will then be used for 
semi-quantitative analysis, if required.

To build a reasonable semi-quant curve, you need only choose 
3–5 analytes that cover the mass range of interest and are easily 
ionized in the ICP (e.g. Li, Co, In, Tl and U would build a good 
curve, representative of the mass response of the XSERIES 2 
ICP-MS).

6. Select the External drift correction. Calibration blocks are set up, 
typically every 10–20 samples, and a drift correction can be applied 
between them, if this check box is ticked.

1

2

3

2. Click on the drop down arrow 
next to each analyte to display 
the dropdown list.
Select the calibration method 
of choice as shown below for 
each analyte.

3. For the internal standard 
analytes select None in the 
method column.
By selecting None, a 
concentration file and 
calibration will not be 
assigned to these analytes.
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Sample Analysis
Step 6 - Creating a Sample List
Note To enable external drift correction to be performed on all samples, 
there must also be a calibration block at the end of the sample list. ▲

7. Select the Calibration concentrations by Element. They can also be 
defined by Isotope, but this is only for use when non-natural 
isotopic abundances occur.

Step 6 - Creating a
Sample List

1. Select the Sample List and then again Sample List.

2. Define the Blanks, Standards and Unknowns using the dropdown 
list as shown. The blank and standards will turn light blue, this is 
the Calibration block and can be copied at the end of the sample list 
and used for External drift correction.

Highlight any sample in the calibration block to be copied and right 
mouse click to append copy - a copy of the whole block will be made.

4

5

6 7
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Sample Analysis
Step 6 - Creating a Sample List
3. Select the number of survey runs and main runs as shown.

4. Select the Fully Quantitative Concentrations for all analytes in all 
standards. Enter standard concentrations, use drag and drop to 
copy across the columns.

The row fill multiplier is very useful when working with 
multi-element standard stocks. Define the concentrations for 
standard 1 and then change the multiplier to 10. Select all the cells 
in the first row and then move to the end of the row.

Click on the bottom right corner of the selected cells and drag the 
box down to standard 3. The rows will then be filled as x10 and 
x100 of standard 1.

5. Click on File in the Menu bar and select Save as to save the current 
experiment.
Alternatively, click on the Queue button to start the acquisition, 
and for any unsaved files, it will ask for the experiment to be saved.

1

2

4

5
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Sample Analysis
Step 7 - View Data Acquisition
Step 7 - View Data
Acquisition

1. To monitor data acquisition, double click on the MS icon in the 
lower right corner of the screen. This will show the PlasmaLab 
Service window.

Step 8 - Viewing
Spectra

1. After the Survey run is completed, the results can be viewed. Go to 
Results > Spectra. A spectrum can be viewed by clicking on the 
cross next to the sample (that is, survey and stability run to enlarge 
the menu). Then double click on the Survey run. The graph below 
shows the complete mass range for the Survey run.

2. Select a zoom option by clicking the right hand mouse button on the 
graph and choosing Mode from the menu. Then choose Zoom 
fixing y at zero.

3. Zoom in on an analyte you wish to view more closely 
(e.g. Pb peaks). Hold down the left mouse button and drag over the 
Pb peaks (204–210 amu).

1. The Real Time Display can be monitored during the acquisition via 
the Technician page.

1
2
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Sample Analysis
Step 8 - Viewing Spectra
4. Now the mass spectrum shows a zoom-in of the mass region. The 
spectrum displays both the pulse counting and the analog data. 
Click once using the right mouse key to show the dropdown menu.

The dropdown menu gives a list of options. You can either Undo 
zoom, this will step back to the previous zoom or Restore to return 
to the original full mass region.

The spectrum can be viewed for either detector mode, or the 
detector analog noise can be eliminated. To eliminate the analog 
noise, place the cursor over View Options. Another dropdown 
menu will be displayed. Therein select Eliminate Analogue Noise.

1

2

4

4-12 XSERIES 2 Getting Started Guide Thermo Fisher Scientific



Sample Analysis
Step 9 - Semi-Quantitative Results
5. To identify the analytes with respect to their isotopic fingerprint, 
click on the peak of interest. Double click on the element of interest 
or most likely interferent.

Note Fingerprinting only works effectively, if the analog noise has been 
removed. ▲

Step 9 -
Semi-Quantitative

Results

Any standard entered for fully quantitative analyses can also be used to 
establish the semi-quantitative response curve. Semi-quantitative results 
can be obtained for any analyte found in the Survey or Main runs that 
does not have a standard calibration, by using the response curve.

1. Click on Results.

2. Click on Calibration Data to view the results.

3. Select the SQ-FQ Block from the dropdown menu.

4. The response curve is displayed. Any point of the curve can be 
excluded by clicking on it (when excluded, it will displayed in red). 
The response curve values in the grid can then be recalculated by 
clicking on Refresh.

5. The results of the mass response are displayed in the table.

5
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Sample Analysis
Step 9 - Semi-Quantitative Results
6. The accuracy of semiquant values can be refined by adjusting the 
RSF value of the analyte. This Relative Sensitivity Factor is the 
measure of the analyte’s response in the ICP-MS compared to the 
theoretical response. The RSF will change for different plasma and 
sample introduction conditions. It can be useful to build a library of 
values for different conditions.

If a calibrated analyte has not been used to build the semiquant 
curve, it is still displayed and, if necessary, its correct RSF value can 
be recalculated.

To recalculate a RSF value, first deselect the point to be recalculated 
by clicking on it with the left mouse button. Then click on the right 
hand mouse button to select the dropdown list and select Calculate 
RSF. The corrected RSF values can be exported to any analyte 
database for later use with the Analyte Database Wizard on the tool 
menu.

7. Click again in the RSF cell with the left mouse button to display the 
corrected RSF value.

8. The results of the semi-quantitative analyses of the entire mass range 
are shown in purple (selected from Numerical Results and then 
Survey Analyte Dilution Concentration). 20–30% accuracy can 

1
2

3 4

5
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Sample Analysis
Step 10 - Fully Quantitative Results
be expected for semi-quantitative analysis, when appropriate 
RSF values are used (see step 7).

Step 10 - Fully
Quantitative Results

1. Click on Results.

2. Click on Calibration Data to view the results.

3. Select the fully quantitative calibration block for viewing.

4. Select the analyte to view its calibration graph.

5. Erroneous points can be excluded from the calibration by clicking 
with the left hand mouse button on the respective point as 
illustrated for Ba Std 1. The point changes red when excluded.

6. Using the dropdown menus in the Curve Fitting Options box, a 
choice of weighting the calibration can be made. Default is none.

1
2

3

4
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Sample Analysis
Step 10 - Fully Quantitative Results
The calibration can also be modified to force through zero, through 
origin or through blank. The latter is recommended.

7. Changes to weighting or forcing can be seen immediately on graph. 
Click on the Refresh button to change the grid underneath and 
recalculate the whole database.

8. Click on Results and then on Numerical Results to view the 
results. The concentrations can be viewed in the analyte dilution 
concentration file. The data, mean, SD and %RSD are displayed for 
all standards and unknown samples.

9. Check the accuracy of the data.

Note The %RSD should in general be less than 2% (where the 
concentration is equivalent to approximately > 300 times the standard 
deviation of the blank). ▲

Any points excluded from the calibration are shown as shaded 
regions. To exclude erroneous data points, right mouse click over the 
cell to be excluded and select Exclude.

5

6

7
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Sample Analysis
Step 10 - Fully Quantitative Results
12. The display parameters can be modified using the Edit display 
parameters icon.

8

9

10
10. The results display can be 

modified to display the run 
times.

For this purpose, click on the 
icon shown.

11

11. Unit sets can be 
adjusted for individual 
elements by using the 
dropdown menu in the 
cell below the element.
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Sample Analysis
Step 10 - Fully Quantitative Results
13. Using the drop down menu as shown below, the sample list is 
displayed, and sample results can be selected.

14. The internal standard is shown in yellow. The table below shows the 
mass-uncorrected ICPS and can be used to check that the response 
does not change significantly throughout the run.

The internal standard can be displayed as the Internal Response 
Factor (used in the calculations) or % internal standard recovery 
(which is the reciprocal of the ISR, expressed as a percentage). The 
% recovery is the value most popularly monitored by analysts 
throughout the world.

12
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Sample Analysis
Step 10 - Fully Quantitative Results
15. To make any changes to the internal standard (that is if the internal 
standard is at a higher concentration than expected or unexpectedly 
in a sample and needs to be deselected), these changes can be made 
in the Sample list.

Click on the sample that needs correcting and select Show 
advanced. In the Internal standard folder select New Internal 
Standard set for this sample. Any changes in concentration or 
selecting different internal standards or deselecting internal 
standards can be made. A new name will be set for the internal 
standard for this sample.

14

15
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Sample Analysis
Step 11 - Printing Report
Step 11 - Printing
Report

Microsoft Internet Explorer 6 is required to preview and print reports. 
Internet Explorer should be set up to enable printing of colored 
backgrounds.

1. This is set up in Internet Explorer > Tools > Internet Options...

2. In Internet Options, select Advanced. Scroll down to Printing. 
Ensure that the box Print background colors and images is ticked.

3. To display the results for printing, click on Reports.

1

2
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Sample Analysis
Step 11 - Printing Report
4. Select the sections which require reporting by ticking the relevant 
boxes.

5. Click on the Refresh button to display the report on screen.

6. Click on the Configure the reports settings icon to enable a 
preview in PlasmaLab. Alternatively, open the report in a 
Windows-associated package and click on Refresh to view the 
report.

7. Use the Save icon to save the report in the appropriate folder.

8. Results can also be copied and pasted from the Results page: 
highlight the results and right mouse click to copy with headings. 
Then paste into a Windows-associated package, that is Microsoft 
Excel or Microsoft Word.

9. It is possible to export the data directly to a *.csv file (comma 
separated variable) from the results grid’s right hand mouse menu. 
This can be used for LIMS or Microsoft Excel data processing.

The data is exported as Unicode characters to allow international 
characters to be recognized. Import into Microsoft Excel requires 
the Excel wizard to be used to choose comma as the variable 
separator.

3
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Sample Analysis
Step 11 - Printing Report
9
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Chapter 5 Operating PlasmaScreen

Objective:

To familiarize yourself working with the PlasmaScreen mode of 
operation. Optimization and usage of PlasmaScreen in cool plasma and 
hot screen modes will be explained in detail.

Cool plasma allows selective reduction of molecular interferences 
(e.g. Ar, ArO) to aid the analysis of trace analytes whose nominal mass is 
identical to that of the interfering species such as K, Ca and Fe. It is also 
useful for the analysis of easily ionizable elements such as Li and Na.

Hot Screen mode allows higher sensitivities to be obtained compared to 
normal plasmas with the plasma screen fitted. Tuning is similar to 
normal plasma except that a little more care is required on the nebulizer 
flow rate to obtain good oxide levels (< 6% for hot screen mode).

This chapter treats the following topics:

“Step 1 - Installing PlasmaScreen” on page 5-2

“Step 2 - Plasma Screen Operation and Configuration Setup” on 
page 5-3

“Step 3 - Tuning PlasmaScreen for Cool Plasma Mode” on page 5-5

“Step 4 - Edit New Analyte Database” on page 5-6

“Step 5 - Create New Experiment” on page 5-8

Sample Preparation

Prepare a 10 ppb Co and In solution in deionized water. It is used for 
cool plasma tuning. Prepare the solution just prior to the analysis:

• Blank DI water + 0.05% HNO3

• 10 ppb Co and In in fresh Milli-Q water

• 1 ppb screen tune containing Li, Na, K, Ca and Fe
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Operating PlasmaScreen
Step 1 - Installing PlasmaScreen
Step 1 - Installing
PlasmaScreen

1. The torch has been removed for cleaning and is ready for re-fitting.

Note The correct alignment of the screen is absolutely vital to 
performance! ▲

The torch, screen and bonnet are designed so that the screen location is 
fixed in the optimum position by way of a quartz pip on the torch body 
and a corresponding hole in the screen leg. The pip fixes the screen 
position and also serves to fix the bonnet position when this item is 
placed over the screen and pushed back until it touches the pip.

Caution It is important that the screen is located correctly via the pip! If 
it is not, and is set up such that the screen is protruding from the end of 
the torch, the plasma is likely to fail to ignite as the ignition spark will 
arc to the protruding tip of the nickel screen. This will also damage the 
screen.
The quartz bonnet must completely cover the screen. If the bonnet does 
not cover the screen correctly, that is it is not pushed fully back to the 
screen locating pip, or if the bonnet is not fitted at all, the plasma will 
again fail to ignite and the screen will be damaged. ▲
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Operating PlasmaScreen
Step 2 - Plasma Screen Operation and Configuration Setup
Note The grounding tab of the screen must be situated completely 
squarely over the grounding pin. A good connection between the 
grounding tab and pin is essential for PlasmaScreen Plus to work 
effectively. The grounding pin itself should not be visible, as the tab 
should cover it completely. ▲

Ensure that the tab on the screen is fitted correctly into the holder in the 
block. The cool gas push fit connector is connected to the torch and 
lined up with the groove in the cartridge, for accurate alignment of the 
torch.

Ensure that the cool and auxiliary gas lines are connected securely to the 
torch. Then close the PTFE locking block over the torch and clip it into 
place.

The torch is then connected back to the spray chamber, and the torch 
box area is closed ready for operation.

Step 2 - Plasma
Screen Operation and

Configuration Setup

The configuration relates to the hardware manually fitted to the 
XSERIES 2 ICP-MS. A new configuration should be set up for each 
hardware configuration. The PlasmaScreen is physically removed or 

1. Switch on the plasma and allow to stabilize for approximately 
15 min.1

2. The PlasmaScreen Configuration is setup from the Instrument 
Control. Click on the Instrument icon.

2
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Operating PlasmaScreen
Step 2 - Plasma Screen Operation and Configuration Setup
fitted by the user. Thus it should have its own configuration, or 
multiple configurations for different sample introduction setups, if 
required (that is glass concentric nebulizer or ultrasonic nebulizer).

3. Click on the Configurations page and Configuration Editor. 
Setting up the configuration allows selecting available accessories 
and particular pre-set instrument settings. Future saved tune 
parameters will be stored here as well.

4. Click on the required PlasmaScreen configuration. Select the 
required accessory.

5. If the required configuration is not available, create a new 
configuration from the icon shown and edit the description.

6. If a required accessory is not available, a new accessory can be 
selected by following the Accessory Wizards instructions.

3

4

5 6
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Operating PlasmaScreen
Step 3 - Tuning PlasmaScreen for Cool Plasma Mode
Step 3 - Tuning
PlasmaScreen for

Cool Plasma Mode

The aim when optimizing the tuning parameters for Cool Plasma is to 
obtain the maximum analyte signal (typically 10 ppb 59Co in deionized 
water) with minimum 40Ar16O signal.

The main changes in tuning parameters compared to Standard mode are 
summarized in the table below.

Aim for a Co signal of approximately 10 Mcps/ppm and a 40Ar16O 
contribution of approximately 100 cps.

The ratio of 59Co/40Ar16O should be a minimum of 100. If it is 
proving difficult to reduce the 40Ar16O to 100 cps whilst aspirating the 
10 ppb Co solution, record the Co signal and aspirate the blank solution 
(deionized water) to remove the possibility of 56Fe contamination in the 
Co stock solution.

1. Click on Tune in the Instrument section. Click on Major. These 
parameters have the greatest effect on the tuning.

2. Use the slider to select the default settings as shown.

3. Click on Minor. These parameters are generally for fine tuning, 
however, for Cool Plasma mode of operation ensure that the 
Forward Power is set to low power as shown.

Tuning Parameter Range or Value

Reduced RF Power range 480 W to 600 W

Negative Pole Bias -10 V

Reduced Extraction range -80 V to -150 V

Hexapole Bias  -5 V

Increased Sampling Depth range 100 to 300

(100 steps back from normal operating position)

Reduced Focus range 2 V to 15 V

Increased Neb gas flow 1.0 L/min - 1.1 L/min

Increased Aux gas flow 1.0 L/min - 1.2 L/min

Increased Coolgas flow 14 L/min - 15 L/min
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Operating PlasmaScreen
Step 4 - Edit New Analyte Database
4. Aspirate the 10 ppb Co solution to optimize the tuning. Adjust the 
RF power, lens settings and nebulizer flow rate to obtain the 
required ratio.

Once the required 59Co/40Ar16O ratio has been achieved, save the 
instrument settings. The ratio can be monitored in the real time 
display.

Step 4 - Edit New
Analyte Database

1. For the use of PlasmaScreen with Cool Plasma, an Analyte Database 
is required to enable monitoring of 40Ar for the major Ca isotope. A 
default Analyte Database for cool plasma operation is provided. It 
can be edited or a new one be created, if required. Click on 
File > New > Analyte Database to create a new one.

1

3

2
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Operating PlasmaScreen
Step 4 - Edit New Analyte Database
2. The database scan regions have to be altered to enable the analysis of 
40Ar.
Select the scan and skip regions by clicking on them in the graphic. 
Click the right hand mouse button on the graphic to add or remove 
scan regions.
Alternatively, type in values in the box on left hand side for each 
individual scan region.

1

2
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Operating PlasmaScreen
Step 5 - Create New Experiment
4. Save As a new Analyte Database in the Data folder as Default 
PlasmaScreen.tea.

Step 5 - Create New
Experiment

Aim: detection limit determination of PlasmaScreen elements.

1. Select Create a new blank experiment from the Experiment Wizard 
by clicking on the Experiment icon.

3
3. Add matrix and polyatomics in the database as 

shown:

Click on New to add any polyatomics or matrix 
ions common to the samples being analyzed. The 
species shown below are defaults to all databases.

Any unwanted ones can be removed by right hand 
mouse clicking on the highlighted species in the 
list and choosing Delete.

4
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Operating PlasmaScreen
Step 5 - Create New Experiment
2. Select the PlasmaScreen Analyte Database previously created for this 
experiment, or the default database for cool plasma provided with 
PlasmaLab.

3. In Setup > Configurations Editor select the configuration for 
PlasmaScreen by ticking the Use box. This can be left, if 
PlasmaScreen is the current configuration anyway.

4. The Available Accessories and Devices are pre-selected in Instrument 
Control. If an accessory is not available, select the accessory using the 
Instrument icon and the Accessory Wizard as described in 
Chapter 1: “Optimizing the Signal”, before continuing to edit the 
Experiment.

1

2
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Operating PlasmaScreen
Step 5 - Create New Experiment
5. Select the current instrument settings by ticking the Use box. This can 
be left deselected, if the current instrument settings are to be used. 
However, instrument settings must be selected, if multiple settings 
sets are to be used (that is, Cool Plasma and Hot Screen mode in the 
same acquisition).

6. In Setup > Timings select the time for the uptake (measured by the 
time taken for the sample to reach the plasma) and washout. It is 
typically set between 30 s and 90 s depending on the sample matrix 
and concentration.

7. Select the analytes via Setup > Analyte menu as shown. For the 
detection limit determination, the analytes 7Li, 23Na, 39K, 40Ca and 
56Fe are selected.

Note 40Ca can now be selected, which is the most abundant isotope of 
calcium. ▲

Caution Take care not to use 40Ca in normal or hot screen plasma 
conditions as the high levels of 40Ar produced will cause high count 
rates to be seen on the detector. Even though the XSERIES 2 ICP-MS 
has a mechanism to handle trips on the detector, the lifetime of the 
detector will suffer when exposed to high levels for prolonged periods. ▲

3

4

5

6
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Operating PlasmaScreen
Step 5 - Create New Experiment
8. Set up the Acquisition Parameters for a Survey run and Peak Jump 
Main run. The default parameters are shown below.

9. Select Calibration Method. Select the Method from the drop down 
menu as Fully Quant for all analytes.

10. The remaining parameters are set as default as shown, with the 
exception of Forcing which is recommended to be set as Force 
Through Blank selected from the drop down menu.

7

8
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Operating PlasmaScreen
Step 5 - Create New Experiment
11. Enter the Sample list as shown for the DIW Blank and the 1 ppb 
Std.

Note 10 repeats are selected for the blank for detection limit 
determination. ▲

12. Add the Fully Quantitative concentration of 1 ppb.

13. Save and Queue the experiment.

14. Calculate the detection limits via the Analyte Dilution Conc page, 
by using a user pre-dilution factor of 3. This will show a blank 
standard deviation of 3 times the actual blank standard deviation 
(that is, equal to the 3 σ detection limit).

9

10

11

12
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Chapter 6 CCT Operation

Objective:

To familiarize yourself working with the CCT option. The optimization 
using Collision Cell Technology and the use of different gases will be 
explained in detail.

This chapter treats the following topics:

“Step 1 - CCT Setup” on page 6-1

“Step 2 - Tuning CCT” on page 6-2

“Step 3 - Tuning CCTED” on page 6-4

“Step 4 - Create an Experiment” on page 6-5

“Step 5 - Data Interpretation” on page 6-8

Step 1 - CCT Setup

2. A new configuration can be created using the Configurations menu 
and the Configuration Editor page, in which all the new instrument 
settings will be stored. Click on the New Configuration icon.

3. Enter a configuration description as shown (that is, CCT Default) 
and tick the Use box for the new configuration.

Solution required for this practical:

Prepare a 10 ppb Tuning Solution containing Co, In, Ce and U in 2% 
HNO3. Recommended gas for multi-element analysis is an 8% H2 in 
He mix.

1. The gases required to run CCT are set up in Instrument Control. 
The accessories required for the experiment can also be configured 
here. Click on the Instrument icon to open Instrument Control.
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CCT Operation
Step 2 - Tuning CCT
4. The Additional Mass Flow Controllers required to control the gases 
for CCT must be set up within the Configuration Editor. Type in 
the name of the CCT gas in the Identifier box and select the correct 
gas in the Conversion Factor box by clicking on the downward 
arrow in the right hand side of the box to display the menu. The 
conversion is related to helium gas (that is, He factor equals 1.0). 
For mixed gases choose the setting for the bulk gas.

5. To add or edit a gas conversion, right mouse click on the row to be 
edited, to display the options.

Step 2 - Tuning CCT 1. Before tuning the CCT, it is recommended to have good standard 
mode tuning first.

2

3

4

5
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CCT Operation
Step 2 - Tuning CCT
2. Set the chosen CCT Mass Flow Controller(s) to 6 mL/min for a 
minimum of 30 s to purge the lines before tuning.

If the CCT option has not been used for several days, if the gas 
supply has been changed, or if a leak in the lines has just been fixed, 
the gas lines will need to be purged overnight to remove entrained 
water vapor. This increases oxide formation and affects 
CCT performance.

3. The typical tuning parameters for CCT are shown below. The main 
differences between standard mode and CCT tuning are that the Pole 
Bias is set to negative (usually -10 V), the Hex Bias is also set to 
negative (typically about -5 V) and the Focus drops from around 
+19 V to approximately 0 to +5 V, depending on the type of 
interface cones being used.

4. In Instrument Control > Tune, monitor the elements 59Co, 115In 
(target 300,000 cps), and 238U for maximum signal. Also maximize 
the ratio 59/56 (target > 200).
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CCT Operation
Step 3 - Tuning CCTED
5. Tune the gas flow rate and lenses to give low counts at mass 56ArO, 
while keeping good transmission at 59Co, 115In, and 238U.

Typical gas flows when using 8% H2 in He mixture are in the range 
4-7 mL/min.

Step 3 - Tuning CCTED The purpose of CCTED is to allow the interferences from the plasma to 
be removed whilst screening out or preventing the formation of new 
interferences in the collision cell.

1. Before tuning the CCTED mode, there must already be a good 
CCT tuning (see “Step 2 - Tuning CCT” on page 6-2). Select a 
saved CCT tune file as shown below:

2. Starting with the Hex Bias, reduce the differential between it and the 
Pole Bias towards zero, while monitoring 115In for maximum signal 
(target 50,000 cps) and minimizing the CeO/Ce ratio (target 0.03).

The Pole Bias can be increased slightly (typically to -9.5 V) and the 
Hexapole bias set to -10 V to achieve CCTED conditions. This sets 
up a small energy discrimination barrier between the hexapole and 

6. Extra instrument parameters can 
also be monitored when tuning, by 
clicking on the downward arrow 
key in the Monitor box.
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CCT Operation
Step 4 - Create an Experiment
the quadrupole. By changing the magnitude of this barrier, oxide 
and other polyatomic interference transmission can be dramatically 
reduced, but at the expense of sensitivity.

Example: CCT Experiment Now that the signal has been optimized, the system is ready for analysis. 
An experiment can be set up to scan over the 70 to 90 mass region and 
use the PlasmaLab fingerprint function to place the isotopic fingerprint 
of Se on mass 80 and As mass 75. To demonstrate the removal of Ar2 
(mass 80) and ArCl (mass 75).

Step 4 - Create an
Experiment

1. Select Create a new blank experiment.

2. Select the Default CCT.tea database. This database allows scanning 
over regions, such as 40Ar (40Ca), 75ArCl (75As), and 80Ar2 (80Se). 
These were previously skipped due to interference attenuation of 
argon-based polyatomics.

Solution required for this practical:

Prepare a 10 ppb solution of Co, As and Se in 5%HCl and a 5% HCl 
blank.

1
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CCT Operation
Step 4 - Create an Experiment
3. Define the Analyte menu for Co, As and Se. The major Se isotope at 
mass 80 can now be selected.

4. Any default interference equations that were present for 
interferences on As and Se can be removed by right mouse clicking 
on the Equation box to view the drop down menu. Select Disable 
interference equation.

5. Select the Acquisition Parameters as shown below for Main Scan 
only.

3 4
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CCT Operation
Step 4 - Create an Experiment
6. Click the right mouse button to view the menu to change between 
Add Regions or Remove Regions, if required on the graphic of the mass 
range.

7. Set the scan region to include the range from mass 23 to 85. Point 
the mouse over the scan region. Left mouse click and drag over the 
region to be included.

8. Define the sample list for the analysis.

9. Save the experiment as CCT scan As, Se, Co.

5

8
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CCT Operation
Step 5 - Data Interpretation
10. Queue the experiment.

Step 5 - Data
Interpretation

View the spectra in Results > Spectra, and double click on both blank 
and sample survey.

Zoom in to region between mass 70–85 amu to show removal of ArCl 
(mass 75) and Ar2 (mass 80), enabling 10 ppb As (mass 75) and Se 
(mass 80) to be measured easily, in a high chloride matrix.

9

6-8 XSERIES 2 Getting Started Guide Thermo Fisher Scientific



Chapter 7 Maintenance

Objective:

This chapter contains general maintenance instructions for the 
XSERIES 2 ICP-MS. If you follow these instructions, you will obtain 
the best possible performance with the instrument. The XSERIES 2 
ICP-MS is a precision instrument which will yield high performance for 
a long time, if it is properly and regularly maintained. You will be taken 
step by step through all aspects of routine maintenance.

This chapter treats the following topics:

• “Step 1 - Peristaltic Pump Tubing” on page 7-2

• “Step 2 - Spray Chamber” on page 7-3

• “Step 3 - Removing Glassware” on page 7-3

• “Step 4 - Cleaning Glassware” on page 7-5

• “Step 5 - Nebulizer Maintenance” on page 7-6

• “Step 6 - Refitting Glassware” on page 7-7

• “Step 7 - Cleaning Cones” on page 7-8

• “Step 8 - Replacing Multiplier” on page 7-11

• “Routine Maintenance Checklist” on page 7-20

Caution Take care to wipe up any spillages that occur when handling 
acids or organic solvents near the instrument. Otherwise, the enamel 
coating may corrode. Before using any cleaning or decontamination 
methods except those specified by the manufacturer, the user should 
check together with the manufacturer that the proposed method will 
not damage the equipment. ▲

Warning Pay particular attention to the area inside the torch box where 
the sample introduction glassware is mounted. As acids tarnish the 
surface finish, wipe up spills. Wear protective gloves while doing this! If 
for any reason, you want to clean the instrument panels, use a diluted 
soap solution and paper towels to wipe down the panels. ▲
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Maintenance
Step 1 - Peristaltic Pump Tubing
Step 1 - Peristaltic
Pump Tubing

Note The condition of the peristaltic pump tubing can affect the 
stability of the ion beam. Therefore, the peristaltic pump tubing should 
be replaced regularly: for a typical 40 h working week, it is 
recommended to replace it weekly. ▲

1. Remove the sample uptake tube from the sample and drain the 
sample introduction glassware and all tubing. Stop the peristaltic 
pump by using Accessories Control.

2. Wipe the surface of the peristaltic pump rollers and tension arms 
with a dry cloth to remove any dust.

3. Replace the sample uptake tubing with a sufficiently long 
0–2 mL/min Tygon® tubing with orange/yellow collars 
(P\N 1200211). If it proves difficult to insert the PTFE tubing in 
the ends, widen them by inserting the end of a clean micro pipette 
tip.

4. Replace the drain tubing with a piece of 0–5 mL/min Tygon® tubing 
with white/black collars (P/N 1200212).

5. Place the two pieces of Tygon® around the barrel rollers. Take care 
that they are not twisted and secure them in place using the collars 
and brackets. Attach the tension arms. Ensure that the Tygon® tubes 
are fitted for correct sample and drain flow direction when the 
peristaltic pump is operating.

6. Switch the peristaltic pump on. Check that sample is being taken up 
into the instrument and being drained efficiently. If needed, adjust 
the tension on the Tygon® tubing using the thumbscrews on the 
peristaltic pump.

Note Do not over-tighten, as this would reduce the tubing lifetime! ▲

7. If an autosampler is being used, renew the wash station tubing 
whenever the sample uptake and drain tubing are changed. If the 
sample to be analyzed contains a high percentage of organic solvent, 
the pump tubing should to be replaced with solvent-resistant 
isoversinic pump tubing.

The uptake tube has an inner diameter of 0.5 mm (P\N 1200092). 
The wider drain tubing has an inner diameter of 2 mm 
(P\N 1200093).
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Maintenance
Step 2 - Spray Chamber
Step 2 - Spray
Chamber

Due to the acidic nature of most sample types in ICP-MS, the O rings 
at the rear side of the impact bead spray chamber, which secure the 
nebulizer in place, can degrade and become brittle over time. This is 
observed as a discoloration of the O rings. It can lead to leakage of the 
nebulizer gas from the rear side of the impact bead spray chamber and 
poor signal stability.

Note Old O rings should be carefully removed using a set of tweezers 
and be replaced with two Kalrez O ring seals (P\N 1201833). Rinse 
adequately with a non-aggressive solvent at the end of a sample set to 
prolong the lifetime of the O rings. ▲

Step 3 - Removing
Glassware

Removal and cleaning of ICP glassware and fittings is carried out to 
reduce blank levels for elements which tend to accumulate on the 
glassware. For higher productivity, Thermo Fisher Scientific 
recommends having two sets of glassware available for use, one set in the 
XSERIES 2 ICP-MS and the other set being cleaned in preparation for 
use.

Alternatively, if the analytical program alternates between ultra trace 
determination and relatively high level/complex matrix work, a 
complete set of glassware and cones should be assigned to each.

1. Switch the XSERIES 2 ICP-MS into Operate mode. Rinse the 
sample tubing and glassware by aspirating deionized water into the 
impact bead spray chamber.

2. Switch the XSERIES 2 ICP-MS off, into Vacuum ready. Drain the 
complete sample introduction system.

3. Release the push-fit connector on the nebulizer gas line.

Caution With great care, gently remove the nebulizer from the rear side 
of the impact bead spray chamber. ▲

Note To remove the push-fit connectors, push the collar towards the 
connector body whilst gently pulling the tube away from the 
connector. ▲
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Maintenance
Step 3 - Removing Glassware
4. Open the torch box cover. Then 
open the torch box RF shield. 
Remove the metal clip that fixes 
the transfer tube (the elbow) to 
the rear side of the torch.

5. Lift up the slider that 
holds the Peltier 
cooler in place around 
the impact bead spray 
chamber and place it 
into the higher rest 
position. Gently 
remove the spray 
chamber from the 
XSERIES 2 ICP-MS.
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Maintenance
Step 4 - Cleaning Glassware
6. Release the two push-fit connectors that supply the coolant and 
auxiliary gases to the torch. Release the metal clip on the 
PTFE block that holds the torch in place. Slide the transfer tube 
(elbow) backwards away from the torch and gently pull the torch 
clear of the block and coil.

Step 4 - Cleaning
Glassware

1. The torch, impact bead spray chamber, transfer tube and nebulizer 
may be cleaned by soaking them in a laboratory glassware cleaner 
(e.g. 5% Decon™ 90 or similar) for 30 min. Raising the temperature 
will speed up the process.

Caution Do not boil the liquid when cleaning polypropylene 
components as the plastic will degrade! 50–60 °C are sufficient. ▲

Release the push-fit for 
the Aux and Cool gas.

Release the metal clip.

Warning When handling the corrosive acids required to perform the 
cleaning procedure described below, take the following precautions:

Wear protective clothing.

Use acid resistant laboratory gloves and glasses.

Make yourself aware of all safety procedures in case of spillage or 
exposure to skin or eyes before commencing the cleaning.

The acid cleaning of the glassware should take place in a fume hood. ▲
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Maintenance
Step 5 - Nebulizer Maintenance
2. Rinse at least three times with deionized water. Insert the impact 
bead spray chamber in 10-20% Analar grade nitric acid. Leave it 
there until the glassware is required for use. For a thorough cleaning, 
the soaking period should exceed 6 h. Alternatively, items can be 
cleaned in less than 1 h with an ultrasonic bath and the same 
cleaning solution.

3. Prior to re-installing the glassware, remove it from the nitric acid 
and wash it at least three times in fresh deionized water. Finally, 
allow it to air dry completely. If any components are to be stored for 
some time before use, they should be placed in metal-free sealed 
plastic bags.

4. The torch should be replaced (P\N 3600969), if significant 
devitrification of the injector tip is evident, as this can produce high 
blanks for sodium and other analytes.

5. Inspect the tip of the nebulizer using a magnifying glass. If the tip 
appears damaged in any way, it should be replaced (P\N 4600294).

Damaged nebulizers can give rise to poor stability and sample 
transport efficiencies. Replace the O rings in the rear side of the 
impact bead spray chamber, if the nebulizer seal is not good. If there 
is any damage evident to the impact bead spray chamber, it should 
be replaced.

Step 5 - Nebulizer
Maintenance

The XSERIES 2 ICP-MS is supplied with a glass concentric type 
nebulizer. With use, these nebulizers may become blocked. A blockage is 
typically caused by particulate matter present either in the supply gas or 
in the sample. To prevent nebulizer blockage, follow the general rules 
below:

• Filter the supply gas by installing a low impedance gas filter inline. 
This prevents particulate matter present in the gas or gas lines from 
lodging in the nebulizer.

• Filter the sample. This is recommended provided that the solid 
material present in the sample is not of analytical importance. 
Typically, the nebulizer will not lose efficiency when analyzing 
samples containing small particle size matter because the design of 
the sample capillary is sufficiently robust for the analysis of such 
samples.

• Rinse the nebulizer.
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Maintenance
Step 6 - Refitting Glassware
Note This is extremely important when switching the XSERIES 2 
ICP-MS off at the end of a sample analysis. ▲

Solids may deposit in the nozzle, restricting the nebulizer and 
causing a loss in performance. Allow the nebulizer to dry before 
turning off the gas supply. Make sure that the sample uptake tube is 
disconnected or arranged so as to prevent siphoning into the 
nebulizer when the gas is switched off. This procedure also extends 
the lifetime of the O rings fitted to the impact bead spray chamber.

Should the nebulizer become blocked, apply compressed gas to the 
nozzle and backflush the blockage. Alternatively, flush the nebulizer 
with a 3–5% solution of aqua regia.

If the nozzle is coated in crystalline deposits, soaking in dilute nitric 
acid (2%) is sufficient.

Caution Do not use an ultrasonic bath to remove blockages or during 
nebulizer cleaning as cavitation and ultrasonic vibrations can cause 
irreparable damage to the nebulizer tip! ▲

Step 6 - Refitting
Glassware

1. Attach the push-fit connectors containing the auxiliary and cool gas 
lines to the arms of the torch. The cool gas arm of the torch is lined 
up with the groove in the cartridge. In this way, the torch is always 
aligned in the same place.

2. The PTFE block cartridge is closed over the torch, and the metal 
clip is secured in place.

Warning When handling corrosive acids such as aqua regia take the 
following precautions:

Wear protective clothing.

Always use acid resistant laboratory gloves and glasses.

Make yourself aware of all safety procedures in case of spillage or 
exposure to the skin or eyes before commencing the cleaning.

Preferably the acid cleaning of the glassware should take place in a fume 
hood.

Follow local health and safety procedures. ▲
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Maintenance
Step 7 - Cleaning Cones
3. Replace the transfer tube and then the impact bead spray chamber. 
Secure the transfer tube to the torch and spray chamber using the 
clips provided. If using a Peltier cooler, lift the top half of the Peltier 
cooler into place around the spray chamber from its rest position.

4. Attach the nebulizer to the nebulizer gas line using the push-fit 
connector.

5. Plug the push-fit connector of the nebulizer sample uptake tube into 
the nebulizer supply. Gently push the nebulizer into the rear of the 
impact bead spray chamber.

Caution Take care not to damage the tip! ▲

Attach the drain tube to the drain adapter. Secure onto the impact 
bead spray chamber. Replace the torch box RF shield and close the 
torch box door.

Step 7 - Cleaning
Cones

The condition of the cones affects sensitivity, blank levels and the 
magnitude of signals from some background species (particularly oxide 
species). The actual intervals at which cleaning is required depend on 
the analytical workload and the nature of the samples being analyzed 
(particularly the level of dissolved solids in the samples being aspirated).

Note The cones are manufactured to high precision from pure nickel 
and should be handled with care, particularly the skimmer. The tip of 
the skimmer cone is fragile and as such is easily damaged. ▲

1. Open the torch box door to release the clip between the torch box 
turret and the interface region. Push the torch box enclosure away 
from the rest of the instrument to reveal the interface region.

2. Using the sample cone tool provided, unscrew the locking collar 
holding the sampler in place.

Note Should the sample cone be stuck, carefully insert a small flat 
screwdriver into the edge of the sampler to gently prize it away from the 
interface front plate. If the graphite gasket is damaged, it should be 
replaced (P\N 3004382). ▲
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Maintenance
Step 7 - Cleaning Cones
3. Inspect the sample cone for excessive wear around the orifice. 
Replace, if necessary (P\N 3004661 for X7/HPI interface or 
P\N 3600812 for X5/Xi interface).

4. To clean the sample and skimmer cones, place in an ultrasonic bath 
in ~5% Decon 90 (or similar laboratory detergent) for 
approximately 15 min. Rinse with deionized water, then 
ultrasonicate for 15 min. with deionized water. Dry carefully with a 
non-fibre shedding laboratory wipe, or leave to air dry.

Remove the sample cone first.

Use the sample cone tool to unscrew 
the locking collar of the sample 
cone.

When removing the 
locking collar, hold the 
skimmer cone in place 
with one finger as 
illustrated.

Then remove the 
skimmer cone for 
cleaning.
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Maintenance
Step 7 - Cleaning Cones
5. If further cleaning is required (that is, if performance expectations 
cannot be met), clean the front and rear surfaces of the sample cone 
by gently rubbing from the center outwards with an abrasive pad 
such as Scotchbrite™ (P\N 1026048). Alternatively, apply a fine 
abrasive metal polish such as Polaris (P\N 1041300) made into a 
paste with deionized water.

Note Pay most attention to the area around the orifice. All polish or 
abrasive fibers must be removed before refitting. ▲

Place the sample cone in 2% nitric acid in an ultrasonic bath for 
2 min. Then rinse thoroughly with deionized water. Finally, dry 
carefully with a non-fibre shedding laboratory wipe, or leave to air 
dry.

Caution Do not rub abrasive material over the tip of the cones! Their 
edges must be sharp and regular. ▲

6. The skimmer cone is less mechanically robust than the sample cone 
(particularly at the tip). The edges of the cone must be sharp and 
regular. If there is evidence of damage to the tip, it should be 
replaced (P\N 3200860 for X7/HPi interface or P\N 3600811 for 
X5/Xi interface).

Caution The skimmer cone must therefore be handled with extreme 
care! ▲

The procedure for removal is as follows:

• Remove the skimmer cone through the sample cone hole in the 
front plate (by inserting the recessed cone tool and aligning the 
two lugs in the cone tool in the outer edge of the cone surface; 
then turning counterclockwise, it will be held in place 
magnetically).

• Inspect the skimmer and reject it, if damage is apparent.

• Clean the skimmer cone by placing it in an ultrasonic bath in 
~5% Decon 90 (or similar laboratory reagent) for approximately 
15 min. Rinse with deionized water. Then sonicate for 15 min 
with deionized water. Dry carefully with a non-fibre shedding 
laboratory wipe, or leave to air dry.
7-10 XSERIES 2 Getting Started Guide Thermo Fisher Scientific



Maintenance
Step 8 - Replacing Multiplier
• If further cleaning is required, clean the front and rear surfaces 
of the cone by gently rubbing from the center outwards using an 
abrasive pad such as Scotchbrite™ (P\N 1026048), or 
alternatively apply a fine abrasive metal polish such as Polaris 
(P\N 1041300) made into a paste with deionized water.

Caution Pay most attention to the area around the orifice and clean with 
extreme care! ▲

The rear of the orifice may be reached using a cotton bud and 
Polaris. All polish or abrasive fibres must be removed before 
refitting. Place the cone in 2% nitric acid in an ultrasonic bath 
for 2 min. Then rinse thoroughly with deionized water. Finally, 
dry carefully with a non-fibre shedding laboratory wipe, or leave 
to air dry.

7. Inspect the 28×1.5 mm O ring which is located behind the skimmer 
cone for damage. Replace it, if necessary (P\N 1201240).

8. Reassemble the interface in reverse order. Ensure that the skimmer is 
seated properly and that the front plate and sample cone seals are in 
position and clean.

Tighten the sample and skimmer cones finger-tight to give a good 
thermal and vacuum seal. Move the torch box back into position 
and close the torch box door.

Caution Be careful to push the torch box enclosure into position with 
the door open to avoid damage to the interlock key! ▲

Step 8 - Replacing
Multiplier

This section details the procedure for replacing the AF214 Simultaneous 
Multiplier used in the XSERIES 2 ICP-MS. The XSERIES 2 has been 
specifically designed by Thermo Fisher Scientific to enable easy access 
and replacement of this part.

Note When replacing a multiplier, you will be entering the vacuum 
system of the instrument. In order to ensure that the vacuum system 
does not get contaminated during this process and the optimum 
performance of your XSERIES 2 is maintained, it is important that you 
follow the precautions below. ▲

Caution Always wear powder- and lint-free gloves when handling 
components inside the vacuum system! ▲
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Maintenance
Step 8 - Replacing Multiplier
Note Close the lid of the analyzer chamber whenever you are not 
actively working inside it! ▲

Switching to Shutdown
Mode

Switch to Shutdown mode as follows:

1. With the XSERIES 2 in Vacuum Ready mode, click on the Off 
button.

2. Leave the instrument for 5 min. to vent fully.

Removing Existing
Multiplier

Remove the existing multiplier as follows:

1. Remove the main left hand side cover and store it carefully.

When prompted, click 
on Yes.
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Maintenance
Step 8 - Replacing Multiplier
2. Undo the three clips holding the lid of the analyzer chamber.

3. Open the lid and remove the existing multiplier.

Close the lid until you are ready to fit the new multiplier, making 
sure that the O ring seal around the chamber top is located fully in 
its groove.
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Maintenance
Step 8 - Replacing Multiplier
Fitting New Multiplier Fit the new multiplier as follows:

Caution Only unpack the multiplier immediately before fitting. Install 
immediately. Do not expose the multiplier to air unnecessarily. ▲

1. Remove the new multiplier from its packaging and place with care 
in the locating slots provided in the base of the analyzer chamber.
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Maintenance
Step 8 - Replacing Multiplier
2. Carefully close the lid of the analyzer chamber, making sure that the 
O ring around the chamber top is located fully in its groove. Secure 
the three clips which hold the lid down.
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Maintenance
Step 8 - Replacing Multiplier
3. Replace the main left hand side cover.

Switching to Vacuum
Ready Mode

In PlasmaLab, click on On. At the prompt, select Yes.
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Maintenance
Step 8 - Replacing Multiplier
Each time the turbo pump is started, the user will be prompted to state, 
whether a new detector has been fitted.

• If No is selected, no further action will be taken. All information for 
detector monitoring and cross calibration continues to be stored for 
the current detector.

• If Yes is selected, the user will be prompted to enter the serial 
number for the new detector. The number can be found on the side 
of the box containing the new detector.

Caution It is highly recommended that new detectors go through the 
burn-in procedure. Failure to do this could seriously impact the lifetime 
of the new detector! ▲

• If No is selected for outgassing the new detector, the old detector 
data is archived and new records created for detector monitoring and 
cross calibration.
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Maintenance
Step 8 - Replacing Multiplier
• If Yes is chosen for outgassing, the new records are created, and the 
outgassing dialog is shown.

This dialog shows the progress of outgassing and any events 
(e.g. outgassing has not started because the vacuum has not yet reached 
the trip point). The dialog can be minimized and PlasmaLab can be 
used to process data. However, while the detector is outgassing, no 
analysis can be performed. Outgassing can be aborted or paused, and a 
note will be made in the event log for that detector. Once the automatic 
outgassing is finished, a message will be shown and analysis can begin.

If the turbo pump has been switched off for more than 1 h, when it is 
restarted, if the user chooses No to the New Detector dialog, the 
following dialog is presented.
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Maintenance
Step 8 - Replacing Multiplier
Caution It is highly recommended that all detectors go through the 
burn-in procedure! Failure to do this could seriously impact the lifetime 
of the new detector. ▲

Detector Monitoring On the Detector Monitoring page, the changes that have taken place on 
the instrument during the lifetime of the detector can be viewed. The 
main purpose is for diagnostic reasons, allowing any problems to be 
tracked that may contribute to the lifetime of the detector.

The Detector Monitoring page will show the information for the new 
detector. The various parameters can be displayed using the Options on 
the right of the page.

This data will show every voltage change made on the detector whether 
automatically by the instrument calibration software or manually via the 
Tune page. Monitoring data for older detectors can be viewed by using 
the drop down dialog box at the top of the page.

To view parts of the data in more detail, use the zoom tools:

It is possible to export the monitoring data to a file using the Export 
button.

To highlight any events that occurred in the zoomed region of the 
graph, the highlighting tools can be used to show the information in the 
table below the graph.
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Maintenance
Routine Maintenance Checklist
Routine Maintenance
Checklist

Note The six-monthly and annually procedures listed below should be 
carried out by a qualified service engineer. ▲

Interval Maintenance Procedure

daily Inspect and clean cones, if necessary (that is, if performance is not 
acceptable)

Complete instrument log

weekly Prepare fresh performance monitoring solution

Replace sample and drain peristaltic pump tubing

Exchange ICP glassware (optional)

Clean removed glassware ready for next exchange (optional)

Clean spray chamber drain plug

Clean nebulizer

Check air filters and clean, if necessary

Check multiplier voltages and perform cross calibration

monthly Replace sample uptake tubing

Check rotary pump oil

Check oil mist filters

Check chiller water level in reservoir

six-monthly*

*Thermo Fisher Scientific engineer servicing

Examine lens system and clean, if necessary

Examine penning gauge and clean, if necessary

Change rotary pump oil

annually Replace any worn O rings
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Chapter 8 Troubleshooting

Objective:

This chapter goes through the most typical trivial problems that might 
occur with the instrumentation. It will help you to diagnose a particular 
problem and will recommend remedial action. Many problems in high 
performance instrumentation are the result of trivial concerns, usually 
after some routine maintenance, or if another operator has left the 
instrument in a non-standard configuration.

The two rules of diagnosing potential problems are to:

• examine the recent history of use of the instrument

• consider the simple causes first
(e.g. sample introduction is more likely than quadrupole failure)

The single most useful ‘tool’ for probing analytical concerns and 
hardware problems is the daily instrument log. Once a day (when in 
use) following the routine tuning procedure, the lens, gas and 
RF settings should be documented, and a short term stability test and a 
scan be performed. Hard copies of settings, stabilities, and once a week 
spectra, should be put into the log book.

If you have any doubts about the performance of your instrument, 
trained Thermo Fisher Scientific Technical Support personnel are always 
available to assist you, however trivial you think the problem may be.

This chapter deals with the following topics:

“Step 1 - Vacuum Ready and Operator Mode” on page 8-2

“Step 2 - Sensitivity Problems” on page 8-3

“Step 3 - Signal Drifts with Time” on page 8-4

“Step 4 - Poor Stability” on page 8-5
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Troubleshooting
Step 1 - Vacuum Ready and Operator Mode
Step 1 - Vacuum
Ready and Operator

Mode

Instrument will not go from Vacuum Ready to Operate mode

If the instrument does not respond to any command, check that the 
instrument and data system are communicating via the PlasmaLab 
Service icon. If required, stop and restart the service.

When PlasmaLab fails to start the instrument successfully, a fault 
message is placed in the Technician/Event Log. View this message first 
as it is the quickest and easiest way to pinpoint the problem.

Note The Technician icon changes from yellow to red, if a problem is 
detected. ▲

Plasma will not light

Check that all the
Plasma interlocks
are satisfied on the
Advanced page of
PlasmaLab

Check all gas
lines are securely
connected, free
from kinks and
not trapped.

Check the
PlasmaTorch is in
good condition
with no cracked or
melted areas

Check the Nebulizer
is fitted securely and
the black nebulizer
readback arrow on
the Minor Tune page
goes to 0 during
ignition

Check the ignition
Power in the
Advanced page of
PlasmaLab is set to
800W or greater and
the Post ignisition
power is set to
1200W

Check the condition
of the Cooling water.
Contamination of the
water increases the
conductivity of the

NO

If individual
interlock is not
satisfied check
the following

Hood Closed - Check that the
Faraday Cage door is closed and
firmly secured

Coil Water - Check that external
water supply is switched on and
filter on rear of X Series is not
blocked

Expansion Temp -Check
temperature of sample interface. If
hot check temperature of chiller
water. If cold sensor is faulty.

Ar OK (Gas Control Module) -
Check that Argon supply is switched
on and can supply 80psi
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Troubleshooting
Step 2 - Sensitivity Problems
One of the most common causes for the instrument not to start is a 
failure to light the plasma. The flowchart above shows a simple 
step-by-step guide which covers the most frequent causes of this failure.

Step 2 - Sensitivity
Problems

The majority of concerns about performance surround an aspect of 
signal sensitivity.

No or Low Sensitivity

No

Check
Detector
voltages are
set correctly
and readback
are correct.

Check
solution
concentration

Check Nebuliser
pressure is >1bar
and stable. Check
you can see
aspirated sample in
the spray chamber

Check
instrument is
in Operate
mode and
slide valve is
open

Check that the
Detector is
switched on in the
Advanced page of
PlasmaLab and the
HT readbacks are
correct

Check that the
cables from the
Detector PCB to
the embedded
PC are securely
connected

No signal

Poor sensitivity

No PC signal

Yes

Check Pulse Count for a
known analyte peak. If
necessary check mass 56.
Can you see a peak?

Check Analogue
signal on mass
56. Can you see
a peak?

No

Check Cool and
Auxiliary Gas flow
read backs are
correct and stable

Check that Torch
translation optimizes
in the Horizontal and
Vertical. If necessary
use mass 56.

Check the expansion
pressure is approx.
2mbar and the cones
and sample cone
gasket are in good
condition

Monitor the Lens
slider readbacks
and check they are
stable and match
the setpoints

Call for Service
Support
Thermo Fisher Scientific XSERIES 2 Getting Started Guide 8-3



Troubleshooting
Step 3 - Signal Drifts with Time
In most cases, the problems are trivial, caused by a recent change in the 
sample introduction system or tuning, and can be addressed with ease. 
Only occasionally are they caused by failure of a critical component.

The daily log of instrument performance is most useful. Check the 
previous days log. Make sure that none of the instrument parameters has 
significantly changed. Use the guide above to help to diagnose the 
problem.

Step 3 - Signal Drifts
with Time

The usual cause of signal drift is deposition of matrix on the sample and 
skimmer cones. As material builds up, the sampling and skimmer 
orifices become smaller, and the total ion beam is reduced. Removal and 
cleaning of the cones will resolve this problem.

However, if you suspect an instrumental drift, perform a short term 
stability test and examine the % RSD’s obtained. Use the guide below to 
diagnose the problem:

1. Ensure the total dissolved solids level of the solution being aspirated 
is below the recommended levels (that is, less than 0.2% m/v).

2. Check that the laboratory temperature is stable.

3. Check that the temperature of the coolant water being supplied to 
the instrument is stable.

4. Monitor the temperature of the Peltier control (where fitted), and 
check that it is stable.

5. Monitor the nebulizer slider control read back. Check that it is stable 
and matches the nebulizer slider set point.

6. Monitor the nebulizer pressure value. It should be stable and 
consistent with values previously recorded for the same 
nebulizer/flow conditions.

7. Inspect the sample introduction system. Ensure that all components 
are correctly fitted and all connections are secure.

8. Check that the tension on the peristaltic pump tubing is correct and 
that the pump tube is in good condition.
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Troubleshooting
Step 4 - Poor Stability
9. Monitor the lens slider control read backs and check that they are 
stable. Set the real time display to monitor a low, mid and high mass 
peak (e.g. Be, In, U). Check that the mass calibration is accurate.

Step 4 - Poor Stability Stability is interpreted as the ability of the instrument to produce good 
% RSD values on repeats of the same sample (sometimes defined as 
internal precision). Poor stability is often the reason behind a set of data 
being discarded. Sample matrix can affect stability, especially if the 
nebulizer cannot form a stable aerosol. System-related stability problems 
will occur, if short term stability test % RSD’s worse than 2 to 3% are 
obtained when running a standard tune solution.

1. Ensure the total dissolved solids level of the solution being aspirated 
is below the recommended levels (that is, less than 0.2% m/v).

2. Check that the laboratory temperature is stable.

3. Check that the temperature of the coolant water being supplied to 
the instrument is stable.

4. Monitor the temperature of the Peltier control (where fitted) and 
check that it is stable.

5. Monitor the nebulizer slider control read back. Check that it is stable 
and matches the nebulizer slider set point.

6. Monitor the nebulizer pressure value. It should be stable and 
consistent with values previously recorded for the same 
nebulizer/flow conditions.

7. Inspect the sample introduction system. Ensure that all components 
are correctly fitted and that all connections are secure.

8. Check that the tension on the peristaltic pump tubing is correct and 
that the pump tube is in good condition.

9. Monitor the lens slider control read backs and check that they are 
stable. Set the real time display to monitor a low, mid and high mass 
peak (e.g. Be, In, U). Check that the mass calibration is accurate.
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Glossary
This section lists and defines terms used in this 
manual. It also includes acronyms, metric prefixes, 
symbols, and abbreviations.

A  ampere

AA  Atomic Absorption

ac  alternating current

ACX  Accessory Control Language

ADC  analog-to-digital converter

ASCII  American Standard Code for Information 
Interchange

b  bit

B  byte (8 b)

baud rate  data transmission speed in events per 
second

°C  degrees Celsius

cm  centimeter

cm3  cubic centimeter

CPU  central processing unit (of a computer)

<Ctrl>  control key on the terminal keyboard

d  depth

Da  dalton

DAC  digital-to-analog converter

dc  direct current

Diluent   The solution used to dilute the sample 
from the XSERIES 2 before it enters the ICP-
MS.

EI  electron ionization

<Enter>  Enter key on the terminal keyboard

EPA  Environmental Protection Agency. A part of 
the US federal government that enforces 
environmental laws and provides information 
and guidance to policy makers.

ESD  electrostatic discharge

eV  electron volt

f  femto (10-15)

°F  degrees Fahrenheit

ft  foot

g  gram

G  Gauss; giga (109)

GC  gas chromatograph; gas chromatography

GC/MS  gas chromatograph / mass spectrometer

GND  electrical ground

GPIB  general-purpose interface bus

GUI  graphical user interface

h  hour

Host Computer  The computer used to control 
the XSERIES 2 ICP-MS.

HPLC  high-performance liquid chromatograph
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Glossary: HV
HV  high voltage

Hz  hertz (cycles per second)

ICP  inductively coupled plasma

ID  inside diameter

IEC  International Electrotechnical Commission

IEEE  Institute of Electrical and Electronics 
Engineers

in  inch

ISF  internal standard factor

k  kilo (103, 1000)

K  kilo (210, 1024)

kg  kilogram

l  length

L  liter

LAN  local area network

lb  pound

LC  liquid chromatograph; liquid chromatography

LC/MS  liquid chromatograph / mass spectrometer

LED  light-emitting diode

LIMS  Laboratory Information Management 
Systems

µ  micro (10-6)

m  meter

m  milli (10-3)

M  mega (106)

M+•  molecular ion

MB  Megabyte (1048576 bytes)

MH+  protonated molecular ion

min  minute

mL  milliliter

mm  millimeter

MS  mass spectrometer; mass spectrometry

MS  MSn power: where n = 1

MS/MS  MSn power: where n = 2

MSn  MSn power: where n = 1 through 10

m/z  mass-to-charge ratio

n  nano (10-9)

NIST  National Institute of Standards and 
Technology (USA)

OD  outside diameter

Ω  ohm

p  pico (10-12)

Pa  pascal

PCB  printed circuit board

Peristaltic Pump  The pump on the ICP-MS used 
to control flow of solution into the instrument.

PID  proportional / integral / differential

PlasmaLab   The Thermo Fisher Scientific 
software package used to control and acquire data 
from the XSERIES 2 ICP-MS.

P/N  part number

P/P  peak-to-peak voltage

ppm  parts per million
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Glossary: psig
psig  pounds per square inch, gauge

PTFE  Polytetrafluoroethylene

RAM  random access memory

RF  radio frequency

RMS  root mean square

ROM  read-only memory

RS-232  industry standard for serial 
communications

RSD   The % Relative Standard Deviation. This 
figure is widely used to quote the stability of 
repeat readings taken using an ICP-MS.

RSF  relative sensitivity factors

s  second

T  Tesla

TCDD  2,3,7,8-Tetrachlorodibenzo-p-dioxin

TCP/IP  transmission control protocol / Internet 
protocol

TIC  total ion current

Torr  torr

u  atomic mass unit

V  volt

V ac  volts alternating current

V dc  volts direct current

vol  volume

w  width

W  watt
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Index
% internal standard recovery 4-18
%RSD 4-16
*.csv file 4-21

Numerics
1026048 7-10–7-11
1041300 7-10–7-11
1200092 7-2
1200093 7-2
1200211 7-2
1200212 7-2
1201240 7-11
1201833 7-3
3004382 7-8
3004661 7-9
3200860 7-10
3600811 7-10
3600812 7-9
3600969 7-6
40Ar 5-6
40Ca 5-10
4600294 7-6
56Fe contamination 5-5
59Co/40Ar16O 5-6

A
abrasive fibers 7-10
abrasive material, using 7-10
accessories control 1-3
accessory control language 4-4
accessory wizard 1-2–1-3
acid cleaning, of glassware 7-5
ACL scripts 4-4
acquisition

parameters 2-6, 4-5
parameters for mass calibration 3-9
time 2-7

adjusting, the lenses 1-5
alignment

of screen 5-2
of torch 5-3

analog noise 4-12–4-13
analyte

database 2-2, 4-2, 5-6

database wizard 4-14
dilution concentration 4-16
selecting 4-4
signal 1-14

Analyte menu 6-6
analytical use 6-1
analyzer chamber 7-12
aqua regia 7-5, 7-7
archived versions

of autotune sequence 1-10
of performance report 2-11

argon 1-2
argon-based polyatomics 6-5
autosampler 1-3, 7-2
autotune 1-8, 2-14

process 1-12
report 1-14
script 1-12
sequence 1-10–1-11
starting 1-8
time 1-13
update sequence 1-13
wizard 1-9

B
background noise 2-5
blank experiment 6-5
blank levels 7-3
bonnet position 5-2

C
calibration 3-1

block 4-9
excluding points 4-15
log file 3-6
method setup 4-8
methods 4-8
routines 3-1

CCT
experiment 6-5
gas 6-2
mass flow controller 6-3
operation 6-1
setup 6-1
tune file 6-4

CCTED 6-4
CeO/Ce ratio 1-14
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Index: D
changing
masses to be displayed in the RTD 1-6
monitored masses 1-6

checks, before switching the instrument 1-1
choosing, a database 2-2
cleaning

cones 7-8
glassware 7-5
instrument panels 7-1
polypropylene components 7-5

clothing 7-5, 7-7
coarse tuning 1-5
Collision Cell Technology 6-1
concentration, for internal standard 4-7
cones 1-1
configuration 1-2, 5-3

editor 1-2, 2-3, 4-2
page 1-15
setup 1-2

conversion factor 3-3
Cool plasma 5-1
correction factor 3-3
correlation, between pulse counting and analog detection 3-2
corrosion 7-1
corrosive acids 7-5, 7-7
creating

CCT experiments 6-5
new experiments 2-2, 4-2, 5-8
sample lists 2-8, 4-9
templates 2-8

cross calibration 3-2, 7-17
factor 3-8

D
damage, of tip 7-8
damage, to nebulizer tip 7-7
data interpretation 6-8
database

choosing 2-2
scan regions 5-7

decontamination methods 7-1
Default CCT.tea 6-5
delay time 4-3
deposition, of matrix 8-4
detection limit 5-10, 5-12

determination 5-12
detector

burn-in procedure 7-17, 7-19
calibration 3-2
calibration software 3-3
cross calibration 3-2, 3-7
lifetime 3-1, 5-10
monitoring 3-13

setup wizard 3-2
voltages 1-8

detector monitoring 7-17, 7-19
Detector Monitoring page 7-19
Detector out gassing dialog box 7-18
devitrification, of injector tip 7-6
diagnosing, potential problems 8-1
disabling, interference equations 6-6
discoloration, of O rings 7-3
doubly charged species 2-5
drift correction 4-8
duration, of autotune process 1-12
dwell times 1-7

analytes 2-7

E
editing, new analyte database 5-6
energy discrimination barrier 6-4
engineer servicing 7-20
Excel wizard 4-21
excluding points, from calibration 4-15
experiment

setup 2-3, 4-2
wizard 2-2, 4-2, 5-8

exporting, data 4-21
exposure, to skin or eyes 7-5
external drift correction 4-9

F
failed criteria 2-14
failure, to light plasma 8-3
Faraday cage 1-1
fine tuning 1-5–1-6
fingerprinting 4-13
fitting, new multipliers 7-14
focus 6-3
fully quantitative results 4-15
fume hood 7-5, 7-7

G
gas conversions 6-2
gas, for multi-element analysis 6-1
gases, for CCT 6-1–6-2
glassware 1-1, 7-3
global tune page 1-8
gloves 7-1, 7-11
graphite gasket 7-8
grounding, of screen 5-3
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Index: H
H
hexapole 6-4

bias 6-3–6-4
high blanks, for sodium and other analytes 7-6
highlighting tools 7-19
history, of instrument use 8-1
host computer 3-1
Hot Screen mode 5-1

I
ignition failure, of plasma 5-2
impact bead spray chamber 7-3, 7-6
importing, mass calibrations 3-12
installation

ID100 Autodilutor 4-1
PCI card 3-1
PlasmaScreen 5-2
preparation 2-1

instrument
calibration wizard 3-1, 3-3, 3-9
control 6-1
database 3-1, 3-12
log 8-1
pre startup status 1-1
settings 1-2, 2-4, 5-10
setup sample 3-1

interface cones 6-3
interference correction equations 4-5, 6-6
interlock key 7-11
internal response factor 4-18
internal standard 4-4, 4-6, 4-18

concentration 4-7
selection 4-6–4-7

internal standardization method 4-7
Internet Explorer 4-20
isotope ratios 2-7

selection 2-7
isotopic fingerprint 6-5

L
laboratory

glassware cleaner 7-5
gloves and glasses 7-5, 7-7
temperature 8-4–8-5

leak, in the lines 6-3
leakage, of nebulizer gas 7-3
lens slider control readbacks 8-5
lid, of analyzer chamber 7-12
lifetime

of detectors 5-10, 7-17, 7-19
of tubing 7-2

log book 8-1

log, of instrument performance 8-4

M
magnifying glass 7-6
main run 4-5
maintenance 7-1, 8-1
manual

slide controls 1-4
tuning 1-4

mass calibration 2-8, 3-9, 8-5
of quadrupole 3-10
wizard 3-10

mass flow controllers 6-2
matrix ions 5-8
ME solution 3-2
metal polish 7-10
molecular interferences 5-1
Monitor box 6-4
monitoring

data acquisition 4-11
instrument parameters 6-4
oxides 2-5
uptake and wash 4-4

multiplier
unpacking 7-14

N
nebulizer

blockage 7-6
cleaning 7-7
flow rate 5-1
maintenance 7-6
pressure value 8-4–8-5

nebulizer gas
flow 1-12, 1-14
setting 1-14

nebulizer slider
control readback 8-4–8-5
set point 8-4–8-5

nitric acid 7-6
non-matching cross calibration point 3-8
non-natural isotopic abundances 4-9
number, of sweeps 2-6–2-7

O
O rings 7-3
operating, PlasmaScreen 5-1
Operator mode 8-2
optimizing

lenses 1-12
signal 1-1, 1-4
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Index: P
torch position 1-12
tuning parameters for Cool Plasma 5-5

organic solvents 7-2
orifice 7-10–7-11
outgassing 3-13, 7-18
oxide formation 6-3

P
particulate matter 7-6
peak center 3-12
peak jump 2-6, 4-6
peak shapes 2-8
Peltier chiller 7-4

temperature 1-2
performance report 2-9–2-10, 2-13

acquisition wizard 2-10
printing 2-13
saving 2-13
test 2-9
viewing results 2-14

performance report wizard 2-9
finishing 2-13

performance test 2-14
peristaltic pump 1-3

replacing tubing 7-2
tubing 1-1, 7-2

plasma, ignition failure 5-2
PlasmaLab 1-15

fingerprint function 6-5
PlasmaScreen

configuration 5-4
configuration setup 5-3
operation 5-3

pole bias 6-3–6-4
polyatomic interference transmission 6-5
polyatomics 5-8

argon-based 6-5
polynomial equation 3-3
print preview 1-16
Printer icon 1-15
printing

autotune report 1-14
performance report 2-13
report 4-20

progress, of outgassing 7-18
pulse counting 1-3

Q
quadrupole 3-9, 6-5
quartz bonnet 5-2
quartz pip 5-2

R
rabbit option 4-4
ratio, of 59Co/40Ar16O 5-5
real time display 1-4
recalculating, RSF values 4-14
recessed cone tool 7-10
refitting glassware 7-7
Relative Sensitivity Factor 4-14
removing

blockages 7-7
glassware 7-3
interferences, from the plasma 6-4
multipliers 7-12
push-fit connectors 7-3
skimmer cones 7-10

replacing
multipliers 7-11
peristaltic pump tubing 7-2

resolution settings 4-6
response curve 4-8, 4-13
routine maintenance checklist 7-20
row fill multiplier 4-10
RSF value 4-14
RTD display 1-14

S
sample

analysis 4-1
introduction system 8-4–8-5
label 3-8
list 2-8, 6-7
matrix 8-5
types 7-3

sample analysis 7-7
sample cone tool 7-8–7-9
sample introduction

glassware 7-1
setups 1-2
system 1-2
timings 2-4

scan region 6-7
screen 5-2

grounding 5-3
position 5-2

SD 4-16
selecting

analytes 4-4
autotune sequences 1-9
internal standards 4-7
numerator and denominator 1-7

semi-quant curve 4-8
semi-quantitative results 4-13
sensitivity problems 8-3
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serial number, of new detectors 7-17
service engineer 7-20
settings, for resolution and detector voltages 1-8
short term stability test 2-1, 2-5, 2-9
Shutdown mode 7-12
signal

drifts 8-4
sensitivity 8-3

skimmer cone 7-8, 7-10
replacing 7-10

skip regions 2-6
solid material, present in the sample 7-6
spillages 7-1, 7-5, 7-7
spray chamber 7-3
stability 8-5

of ion beam 7-2
standard startup routine 2-1
starting

acquisition 2-9, 4-10
sample uptake 3-4

start-up cycle 1-2
supply gas filter 7-6
survey 4-5

run 2-6, 4-11
scan 2-2

switching on, the instrument 1-2

T
Technician icon 8-2
technician/event log 8-2
temperature

coolant water 8-4–8-5
laboratory 8-4–8-5
Peltier control 8-4–8-5

templates 2-9
routine analysis types 2-8

tension, on peristaltic pump tubing 8-4–8-5
timings, shortening 4-4
tip, of nebulizer 7-6
torch 1-6, 5-2

optimization 1-13
replacing 7-6

total dissolved solids level 8-4–8-5
trace elements 3-2
transmission 6-4
troubleshooting 8-1
tubing lifetime 7-2
Tune page 1-3, 2-9
tuning

CCT 6-2

CCTED 6-4
parameters 1-2
parameters for CCT 6-3
PlasmaScreen, for Cool Plasma Mode 5-5

tuning solution 1-3, 1-12, 2-1
for CCT 6-1

turbo pump 7-17
tweezers 7-3

U
ultrasonic bath 7-7, 7-9
unpacking, multipliers 7-14
uptake time 2-4, 4-4
user pre-dilution factor 5-12

V
Vacuum Ready mode 7-16, 8-2
vacuum system 7-11
verifying installation 5-1
viewing

cross calibration graph 3-7
data acquisition 4-11
detector cross calibration 3-6
results of autotune sequences 1-15
results of detector calibration 3-7
results of performance reports 2-14
spectra 4-11

voltage change, made on detector 7-19
voltage setting 1-4

W
washout time 2-4, 4-4
weighting, the calibration 4-15
wizards

accessory 1-2
analyte database 4-14
autotune 1-8–1-9
detector setup 3-2
Excel 4-21
experiment 2-2, 4-2, 5-8
instrument calibration 1-8, 3-1, 3-3
mass calibration 3-10
performance report 2-9–2-13

Z
zoom tools 7-19
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